Guide to preparing the 2015-16 Portfolio Budget Statements

Governance and Resource Management Group
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Overview</td>
<td>4</td>
</tr>
<tr>
<td>1.1 Purpose</td>
<td>4</td>
</tr>
<tr>
<td>1.2 Who should prepare PB Statements</td>
<td>4</td>
</tr>
<tr>
<td>1.3 Structure</td>
<td>5</td>
</tr>
<tr>
<td>1.4 Sourcing information</td>
<td>7</td>
</tr>
<tr>
<td>1.5 Clearance processes</td>
<td>7</td>
</tr>
<tr>
<td>2. Publication requirements</td>
<td>9</td>
</tr>
<tr>
<td>2.1 Security requirements</td>
<td>9</td>
</tr>
<tr>
<td>2.2 Which printer to use and printing specifications</td>
<td>9</td>
</tr>
<tr>
<td>2.3 Delivery to Lockup, the Senate, House of Representatives, Treasury and Finance</td>
<td>10</td>
</tr>
<tr>
<td>2.4 Online publication</td>
<td>13</td>
</tr>
<tr>
<td>Guidance on the preparation of the 2015-16 PB Statements</td>
<td>17</td>
</tr>
<tr>
<td>3. Portfolio Overview section</td>
<td>18</td>
</tr>
<tr>
<td>3.1 Minister(s) and portfolio responsibilities</td>
<td>18</td>
</tr>
<tr>
<td>3.2 Portfolio structure and outcomes</td>
<td>18</td>
</tr>
<tr>
<td>3.3 Portfolio resources made available in the Budget year</td>
<td>19</td>
</tr>
<tr>
<td>4. Entity Overview and Resources section</td>
<td>21</td>
</tr>
<tr>
<td>4.1 Strategic direction statement</td>
<td>21</td>
</tr>
<tr>
<td>4.2 Entity resource statement</td>
<td>21</td>
</tr>
<tr>
<td>4.3 Budget measures</td>
<td>24</td>
</tr>
<tr>
<td>5. Outcomes and planned performance section</td>
<td>28</td>
</tr>
<tr>
<td>5.1 Outcome strategy statement</td>
<td>29</td>
</tr>
<tr>
<td>5.2 Outcome expense statement</td>
<td>29</td>
</tr>
<tr>
<td>5.3 Programme reporting</td>
<td>31</td>
</tr>
<tr>
<td>5.4 Programme objective</td>
<td>33</td>
</tr>
<tr>
<td>5.5 Programme expenses</td>
<td>34</td>
</tr>
</tbody>
</table>
5.6 Programme components
5.7 Programme deliverables
5.8 Programme key performance indicators

6. Explanatory tables and budgeted financial statements section
6.1 Movement of administered funds between years
6.2 Estimates of special account flows and balances
6.3 Australian Government Indigenous expenditure
6.4 Budgeted financial statements
6.5 Departmental comprehensive income statement (showing net cost of services)
6.6 Budgeted departmental balance sheet
6.7 Departmental statement of changes in equity
6.8 Budgeted statement of cash flows
6.9 Departmental capital budget statement
6.10 Departmental statement of asset movements
6.11 Schedule of budgeted income and expenses administered on behalf of Government
6.12 Schedule of budgeted assets and liabilities administered on behalf of Government
6.13 Schedule of budgeted administered cash flows
6.14 Schedule of administered capital budget statement
6.15 Schedule of administered asset movements

7. Related issues
7.1 Machinery of government changes
7.2 Programme and outcome changes
7.3 Working with the templates
7.4 Preparing the Word template for printing
7.5 Preparing the Word template for online publication
7.6 Web accessibility requirements
7.7 Additional guidance on ACM Reports and Appropriation Bills

8. Contacts

9. Glossary of terms
1. Overview

1.1 Purpose

The Portfolio Budget Statements (PB Statements) are formal ministerial documents. Together with the Budget Papers, PB Statements represent a package of documents tabled in Parliament on Budget night, which explain the Government’s budget decisions.

The Appropriation Acts refer to the PB Statements as ‘relevant documents’ to the interpretation of the Acts, according to section 15AB of the *Acts Interpretation Act 1901*. The PB Statements provide additional explanation to the Appropriation Bills and as a result, they must be consistent with the Bills, which once passed by Parliament, become law as Appropriation Acts. Should a discrepancy occur between the Appropriation Acts and the PB Statements, it is the Appropriation Acts that are definitive.

The PB Statements also provide further information (financial and non-financial) at the Portfolio and entity level about the ongoing policy and programme delivery initiatives of the Government.

PB Statements are signed by the respective Portfolio Minister. Signing and arrangements for PB Statements will be determined by the senior Portfolio Minister (the first minister shown in the current Ministry List issued by the Department of the Prime Minister and Cabinet at [https://www.dpmc.gov.au/pmc/parliamentary-information](https://www.dpmc.gov.au/pmc/parliamentary-information)).

1.2 Who should prepare PB Statements

All Commonwealth entities which receive funding through the annual Appropriation Acts (whether directly or through a portfolio department) must be included in the PB Statements. Entities will normally be shown as separate chapters in the PB Statements, unless they are in the process of being merged or consolidated into another.

Where there is more than one department in a portfolio, senior Portfolio Ministers determine how the portfolio should be represented, i.e. whether there is to be a book for each department, or one consolidated book for the portfolio.

Entities are to use the following Portfolio numbers for the covers of their PB Statements:
1.1 Agriculture Portfolio
1.2 Attorney-General’s Portfolio
1.3 Communications Portfolio
1.4A Defence Portfolio
1.4B Defence Portfolio (Department of Veterans’ Affairs)
1.5 Education and Training Portfolio
1.6 Employment Portfolio
1.7 Environment Portfolio
1.8 Finance Portfolio
1.9 Foreign Affairs and Trade Portfolio
1.10 Health Portfolio
1.11 Immigration and Border Protection Portfolio
1.12 Industry and Science Portfolio
1.13 Infrastructure and Regional Development Portfolio
1.14 Prime Minister and Cabinet Portfolio
1.15A Social Services Portfolio
1.15B Social Services Portfolio (Department of Human Services)
1.16 Treasury Portfolio
1.17A Department of the House of Representatives
1.17B Department of the Senate
1.17C Department of Parliamentary Services
1.17D Parliamentary Budget Office

1.3 Structure

The PB Statements contain four levels of information: Portfolio, Entity, Outcome and Programme. To ensure that PB Statements are clear and concise, it is important for entities to include information where it is most relevant. Guidance on the information required in each section of the PB Statements is included throughout this document.

Entities should aim to produce PB Statements that present three key messages:

- What does the Government (through the entity) want to achieve?
- How and through what means it proposes to achieve this?
- How will it know if it is succeeding or making progress?

Entities can publish additional information that goes beyond the requirements of the PB Statements on their websites.

The 2015-16 Portfolio Budget Statements will have the following structure:
Portfolio reporting

Portfolio overview
- Ministers and portfolio responsibilities
- Portfolio structure and outcomes
- Portfolio resource statement

Department/entity reporting

Entity resources and planned performance
- **Section One:** Entity overview and resources
  - Strategic direction statement
  - Entity resource statement
  - Budget measures
  - Changes in entity outcomes and programmes (where applicable)
- **Section Two:** Outcomes and planned performance
  - Outcomes and performance information
  - Outcome 1: Strategy
  - Outcome 1: Expense statement
  - Contributions to Outcome 1
  - Programme 1.1
  - Programme components (where applicable)
  - Programme 1.2 (etc.)
  - Outcome 2: Strategy (etc.)
- **Section Three:** Explanatory tables and financial statements
  - Explanatory tables
  - Budgeted financial statements
- Glossary (optional)

Clear read principle

The 2015-16 PB Statements will cover the current financial year (2014-15), the budget year (2015-16) and the forward estimates years (2016-17, 2017-18 and 2018-19).

A fundamental principle of the Outcome and Programme Framework is the consistency of reporting information over an entity's financial cycle. To achieve this, there must be a clear linkage (a 'clear read') from the Appropriation Bills to the PB Statements, and to the Entity Annual Report. As such, financial and non-financial performance information projected in the PB Statements will need to be reported in the Annual Report.

From 2014-15, the new accounting standard *AASB 1055 Budgetary Reporting* requires entities to include budgetary information for the original Budget (from the
PB Statements) and revised Budget (from a portfolio statement update) in their financial statements, accompanied with variance explanations. The explanations will be audited by the ANAO as part of their audit of the annual financial statements. Consequently, entities are reminded of the importance of maintaining internal documentation in order to substantiate the basis of the estimates included in the PB Statements.

1.4 Sourcing information

The financial information reported in the PB Statements must match with the figures in the Central Budget Management System (CBMS).

CBMS is the central source of budget information and is the basis of whole-of-government figures, the Appropriation Bills, financial data and Budget Papers Nos. 1-4. As such, all appropriation figures must be sourced from CBMS to ensure consistency between the PB Statements, the Appropriation Bills and the Budget Papers.

An entity’s financial management information system may be used to supplement information in CBMS, particularly if information to be published as a lower level in the PB Statements.

1.5 Clearance processes

Portfolios do not need to provide their whole PB Statements document to Finance for checking.

Certain material, however, needs to match exactly the information contained elsewhere in the Budget Papers for which the Treasurer and Minister for Finance are responsible. This includes information on the appropriations and the measures tables. To the extent that information in the PB Statements describes measures published in Budget Paper (BP) No.2, it must be consistent with the measures descriptions in BP No.2 and the PB Statements should not be printed until BP No.2 is cleared.

Table 1.2: Budget measures should be provided to your Finance Agency Advice Unit (AAU) for checking against measures descriptions and Appropriation Bills reports prior to the PB Statements being printed.

Portfolio entities are responsible for ensuring the accuracy and completeness of the information contained in their PB Statements, including the presentation of information that is consistent with CBMS. The following areas should be checked by entities prior to publication:

- the PB Statements are completed in accordance with the guidance and templates provided;
- the measures table matches the final measures list provided by your Finance AAU;
- the Average Staffing Level (ASL) numbers match the numbers published in BP 4;
- all Bills information matches to the Appropriation Bill Schedule produced by the Appropriation Bill report from BEAM; and
- the relevant Chief Finance Officer (CFO) sign-offs on Bills and estimates have been provided to your Finance AAU.
2. Publication requirements

2.1 Security requirements

The PB Statements are classified as Protected and under embargo up until the time they are tabled in Parliament and publicly released. The Treasurer has endorsed this classification and it is the responsibility of each portfolio entity to ensure appropriate security arrangements are made. If staff are unsure of the correct security processes during the budget preparation period, they should contact their entity security adviser.

Issues to keep in mind include:

- PB Statements should be prepared in an area of the entity appropriate for managing Protected material.
- PB Statements documentation should under no circumstances be distributed via unsecure electronic mail.
- The ‘need to know’ principle should be applied in the distribution of all material.
- PB Statements should not be prepared by external companies or contractors who cannot demonstrate that their premises meet the security standards for protected information as provided by the Protective Security Policy Framework (http://www.protectivesecurity.gov.au).

If you have any questions regarding security issues please speak to the security adviser in your entity.

2.2 Which printer to use and printing specifications

Specifications

Hard copies of the PB Statements must be produced on standard B5 size paper (17.6 cm x 25 cm) with a font point size of at least 10 point and using the styles provided in the templates (Attachments B to D) to ensure that the statements are consistent with other budget documents and related papers.

For the covers, entities must use *Tablex System Board 200gsm – Yellow* paper with the **cover text in black**.

For consistency, all portfolios must have the portfolio name made clearly visible on the spine of the documents.

Printer

It is strongly recommended that portfolio departments contact CanPrint to arrange printing for the PB Statements. If printing is carried out ‘in-house’, entities must liaise with Finance and CanPrint to ensure that cover stock, colour and text is consistent with all other Portfolio Entities.
It is the responsibility of each portfolio department to arrange the printing and secure freighting of their PB Statements. The contact officers for CanPrint Communications Pty Ltd are Peter Reid and Andrew Brien on (02) 6295 4450.

Portfolios should make sure they have sufficient hard copies of their PB Statements for their own internal needs, and make additional hard copies of their PB Statements available on request to other stakeholders, not including the distribution requirements listed below, such as:

- Other departments and relevant entities;
- Major client organisations; and
- The libraries of tertiary institutions.

Classification

Please be aware that the PB Statements are classified as Protected documents until they are tabled in Parliament. Accordingly boxes of the PB Statements should be labelled as follows:

Protected – Budget 2015-16
Under Embargo until 20:15 hours 12 May 2015

2.3 Delivery to Lockup, the Senate, House of Representatives, Treasury and Finance

Portfolio departments are to deliver printed copies of the PB Statements to the Senate and House of Representatives Tabling Offices, the Treasury lock-up and Finance by COB Monday, 11 May 2015.

Due to security measures that preclude access of non-authorised vehicles at the entrances to Parliament House, delivery arrangements for PB Statements will be as follows:

- If a portfolio department prints in-house or with a printer other than CanPrint they must arrange for an officer of the entity to deliver the copies of PB Statements for the Senate and the House of Representatives to the Documents Officer, Senate Table Office, SG 25.
- Entity officers who deliver the Statements will require Commonwealth Officer passes and trolleys to transfer the documents from the car park to SG 25. Boxes will have to be x-rayed by security at the entrance—entity officers will be required to unload and reload the boxes at this point.

If you have any queries about or difficulties with these arrangements, please contact the Documents Officer, Senate Table Office. (Phone: (02) 6277 3037)
### Number of books

<table>
<thead>
<tr>
<th>Department</th>
<th>Copies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department of the Senate</td>
<td>120 copies</td>
</tr>
<tr>
<td>Department of the House of Representatives</td>
<td>25 copies</td>
</tr>
<tr>
<td>Department of the Treasury (Lock-up)</td>
<td>120 copies</td>
</tr>
<tr>
<td>Department of Finance</td>
<td>40 copies</td>
</tr>
</tbody>
</table>

**For delivery by COB Monday 11 May 2015 (minimum 305 copies)**

- **Department of the Senate**
  - Publications Officer – Senate Table Office, Room SG 25
  - Department of the Senate
  - Parliament House
  - CANBERRA ACT 2600
  - Ph: (02) 6277 3037

- **Department of the House of Representatives**
  - Table Office – Suite RG 89
  - Department of the House of Representatives
  - Parliament House
  - CANBERRA ACT 2600
  - Ph: (02) 6277 4802

- **Department of the Treasury (Lock-up)**
  - Table Office – Suite RG 89
  - Department of the House of Representatives
  - Parliament House
  - CANBERRA ACT 2600
  - Ph: (02) 6277 4802

- **Department of Finance**
  - Budget Reporting and Framework Team c/o Dario Forner
  - Department of Finance
  - John Gorton Building
  - King Edward Terrace
  - PARKES ACT 2600
  - Ph: (02) 6215 3408

**NB**: PB Statements must be delivered to the Budget Reporting and Framework Team – no PB Statements should be delivered to the AAU.

- **Your Portfolio Minister and advisors (following the Minister’s sign off on the final document)**
- **The Minister representing the portfolio in the other Chamber**

Please confirm number required with your Minister’s office.
### Parliamentary Library
- Acquisitions Librarian
- Parliamentary Library
- Department of Parliamentary Services
- Parliament House
- CANBERRA ACT 2600

<table>
<thead>
<tr>
<th>Parliamentary Committees</th>
<th>Copies</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PB Statements only need to be sent to your portfolio’s relevant parliamentary committee(s), not all the committees listed below. Mailing of the PB Statements after tabling will be permissible when distributing copies to Parliamentary Committees:</strong></td>
<td></td>
</tr>
<tr>
<td>[Name of Committee] PO Box 6100 Parliament House Canberra ACT 2600 Australia</td>
<td></td>
</tr>
<tr>
<td>Community Affairs</td>
<td>5 copies</td>
</tr>
<tr>
<td>Health and Social Services portfolios (includes Human Services)</td>
<td></td>
</tr>
<tr>
<td>Secretary – ph (02) 6277 3515</td>
<td></td>
</tr>
<tr>
<td>Estimates – ph (02) 6277 3515</td>
<td></td>
</tr>
<tr>
<td>Economics</td>
<td>8 copies</td>
</tr>
<tr>
<td>Industry and Treasury portfolios</td>
<td></td>
</tr>
<tr>
<td>Secretary – ph (02) 6277 3540</td>
<td></td>
</tr>
<tr>
<td>Estimates – ph (02) 6277 3540</td>
<td></td>
</tr>
<tr>
<td>Education and Employment</td>
<td>8 copies</td>
</tr>
<tr>
<td>Education and Employment portfolios</td>
<td></td>
</tr>
<tr>
<td>Secretary – ph (02) 6277 3521</td>
<td></td>
</tr>
<tr>
<td>Estimates – ph (02) 6277 3437</td>
<td></td>
</tr>
<tr>
<td>Environment and Communications</td>
<td>5 copies</td>
</tr>
<tr>
<td>Communications and Environment portfolios</td>
<td></td>
</tr>
<tr>
<td>Secretary – ph (02) 6277 3526</td>
<td></td>
</tr>
<tr>
<td>Estimates – ph (02) 6277 3528</td>
<td></td>
</tr>
<tr>
<td>Finance and Public Administration</td>
<td>8 copies</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td><em>Finance, Parliament, and Prime Minister and Cabinet portfolios</em></td>
<td></td>
</tr>
<tr>
<td>Secretary – ph (02) 6277 3439</td>
<td></td>
</tr>
<tr>
<td>Estimates – ph (02) 6277 3534</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Foreign Affairs, Defence and Trade</th>
<th>6 copies</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Defence (including Veterans' Affairs) and Foreign Affairs and Trade portfolios</em></td>
<td></td>
</tr>
<tr>
<td>Secretary – ph (02) 6277 3535</td>
<td></td>
</tr>
<tr>
<td>Estimates – ph (02) 6277 3536</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Legal and Constitutional Affairs</th>
<th>5 copies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attorney-General's and Immigration and Border Protection portfolios</td>
<td></td>
</tr>
<tr>
<td>Secretary – ph (02) 6277 3560</td>
<td></td>
</tr>
<tr>
<td>Estimates – ph (02) 6277 3498</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rural and Regional Affairs and Transport</th>
<th>3 copies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agriculture and Infrastructure and Regional Development portfolios</td>
<td></td>
</tr>
<tr>
<td>Secretary – ph (02) 6277 3511</td>
<td></td>
</tr>
<tr>
<td>Estimates – ph (02) 6277 3511</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Information Research Centre</th>
<th>15 copies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information Research Centre</td>
<td></td>
</tr>
<tr>
<td>Australian National Audit Office</td>
<td></td>
</tr>
<tr>
<td>Centenary House</td>
<td></td>
</tr>
<tr>
<td>19 National Circuit</td>
<td></td>
</tr>
<tr>
<td>BARTON ACT 2600</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Library Deposit Distribution Scheme</th>
<th>29 copies (or check <a href="http://www.finance.gov.au/librarydeposit/">http://www.finance.gov.au/librarydeposit/</a> for latest number required)</th>
</tr>
</thead>
<tbody>
<tr>
<td>C/ Decipha Pty Ltd</td>
<td></td>
</tr>
<tr>
<td>Locked Bag 7760</td>
<td></td>
</tr>
<tr>
<td>Canberra Business Centre ACT 2610</td>
<td></td>
</tr>
</tbody>
</table>

## 2.4 Online publication

**Publishing the PB Statements on the internet**

All Budget documentation will be published on the Internet with hyperlinks between budget documents for ease of reference and to assist reading across these documents. The Australian Government Budget website [www.budget.gov.au](http://www.budget.gov.au) will link readers to PB Statements on the portfolio’s own website.

All portfolios must post their electronic copy of the PB Statements to their portfolio department’s website. This should be posted in an accessible format as
required by the Web Content Accessibility Guidelines issued by Finance (for example, post the document in multiple formats to be sure it can be read by screen readers). The Web Content Accessibility Guidelines and other publishing requirements and guidance are available at [http://webguide.gov.au/accessibility-usability/accessibility](http://webguide.gov.au/accessibility-usability/accessibility), See Section 7.6 of this guidance for more information on making the PB Statements web accessible.

Portfolios should email the Treasury Web Content team ([webcontent@treasury.gov.au](mailto:webcontent@treasury.gov.au)) by no later than **close of business Monday, 11 May 2015** with details of:

- the URL address where the portfolio will post its PB Statements;
- contact details for the author of the PB Statements; and
- contact details for the portfolio's webmaster.

Portfolios should ensure the above information is forwarded on to their internal Web Publishing area for action.

PB Statements **should not** be uploaded onto portfolio departments ‘websites until they are tabled in the Senate** (note, no PB Statements will be tabled in the Senate until the Appropriation Bills are tabled in the House of Representatives).


- Portfolio departments are to scroll down the page until they find the note referencing the ‘2015-16 Portfolio Budget Statements’. The light red column on the right hand side of the entry will show the time the documents were tabled. Please note that no Portfolio will be separately identified.

- It is anticipated that this notice will appear on the Dynamic Red website around 8.15pm on Tuesday, 12 May 2015. If there is any doubt as to whether the PB Statements have been tabled, please call the Senate enquiries number ((02) 6277 3010) who will be able to provide the necessary advice.

Please note that the PB Statements **are not** archived on the Budget.gov.au website – portfolio departments should ensure electronic copies of past PB Statements remain available on their websites.

**Standard file-naming convention**

Portfolios should follow a consistent file-naming convention for electronic copies of the PB Statements as outlined below to aid file comprehension and retrieval for readers who download the documents, and to remove the confusion that occurs when files are not clearly named or numbered.

An example of the recommended convention is:

```
FinancialYear + Portfolio + ‘PBS’ + a file sequence number (i.e. 01, 02 etc) + Chapter Number (or entity name/acronym, etc)
```

Examples would be:

```
2014-15_DBCDE_PBS_01_Parts_A_and_B
```
Note: The file sequence number simply indicates which file would be read first, second, third etc if the document was read like a book. Naming the files in this way means that the order of files downloaded into a sub-directory would be the same order as the order of presentation of chapters in the PB Statements.

This would result in the electronic files being listed in the same order as the printed chapters, and therefore easier and more intuitive navigation for those accessing the files.

Open Government Initiative – publication on data.gov.au

As part of the Government’s Open Government initiative to increase Budget transparency, portfolio departments are now required to provide a copy of finalised PB Statements tables for publication on Data.gov.au under the default Australian Government license (Creative Commons BY 3.0 AU).

The PB Statements tables, as received from portfolios, will be published on Data.gov.au in Excel workbook format, with a separate workbook for each entity.

The collection of PB Statements financial tables will be published on a single page for ease of discoverability and access, by the media and the public, managed by Finance.

This requirement is designed to satisfy the Government’s direction regarding the proactive publishing of government data in a format that facilitates public access and promotes more efficient data sharing and analysis across government, as detailed in the Coalition's E-Government and Digital Economy Policy.

The following financial tables with headings and footnotes will be published on data.gov.au:

- Table 1.1: Entity resource statement;
- Table 1.2: Entity 2015-16 Budget measures;
- Table 2.1: Budgeted expenses for Outcome X;
- Table 2.2: Programme expenses and Programme components;
- Table 3.1.1: Movement of administered funds between years;
- Table 3.1.2: Estimates of special account flows and balances;
- Table 3.1.3: Australian Government Indigenous expenditure (AGIE);
- Tables 3.2.1 to 3.2.6: Departmental budgeted financial statements; and
- Tables 3.2.7 to 3.2.11: Administered budgeted financial statements.

As the Programme deliverables and Key performance indicators tables will not be published, entities are not required to send these tables to Finance.

Where an entity prepares two or more sets of tables, (for example Departmental budgeted financial statements consolidated and non-consolidated), these tables should be included and clearly marked.

As PB Statements information is under embargo until tabled in Parliament, portfolio departments are to coordinate and collate each Portfolio entity’s financial tables and
footnotes and send them to Finance either via CabNet (addressed Dario Forner) or Protected-rated email to BudgetFramework@finance.gov.au by close of business Monday, 11 May 2015.

- Portfolios should ensure that all hidden sheets and cells, comments, links to databases, and other workings are removed from the workbooks before they are sent to Finance.

- To check whether your entity has Protected-rated email, please refer to the Fedlink user list: http://www.fedlink.cybertrust.com.au/.

Portfolio departments should also ensure the following before sending the financial tables to Finance:

- Tables should be provided in unlinked Excel (not picture) format with all totals hard coded;

- Remove any working, calculations or notes that are outside the boundary of each table. We recommend entities use the Paste Special Values function in Excel before removing this data to ensure totals do not change;

- Check that there are no hidden tabs containing ‘other workings or calculations’ and remove any unnecessary cell comments;

- Check that workbooks / tabs are not password protected;

- Entities will be able to and must provide updated files (as a result of a corrigendum) as necessary.

- Finance will not quality assure the data in the tables provided for publishing on data.gov.au. It is the portfolio departments’ responsibility to check the integrity of the data provided in each table and that it matches the published PB Statements.

- For advice on the machine readable file format for the PB Statement tables for data.gov.au or the Open Government initiative, please email data.gov@finance.gov.au.
Guidance on the preparation of the 2015-16 PB Statements
3. Portfolio Overview section

The Portfolio Overview section of the PB Statements is intended to provide the reader with a high-level summary of the portfolio, its Minister(s), portfolio entities, goals/objectives, structure and resources.

This section should include brief descriptions of portfolio entities and only include information which is relevant and specific from a portfolio perspective. This will avoid unnecessary duplication of entity-specific information presented in later sections.

Information at a department or entity level should be included only where it contributes to a broader understanding of portfolio goals and responsibilities.

Components of Portfolio overview:

- Minister(s) and portfolio responsibilities – text description of portfolio of around two pages.
- Portfolio structure and outcomes
  - Figure 1: Portfolio structure and outcomes
- Portfolio resources made available in the Budget year
  - Table 1: Portfolio resources made available in the Budget year

3.1 Minister(s) and portfolio responsibilities

This section should provide a description of the Portfolio Ministers and the structure of the portfolio, as well as its objectives at a strategic and high level. Specifics of particular portfolio entities should be left to the relevant entity's section.

It should include a brief discussion of common themes across the portfolio outcomes, for example, the broad impacts and/or trends of health policy on the Australian Community (Health portfolio), or improvements in Indigenous Affairs (Prime Minister and Cabinet portfolio). Portfolios should also take into account the following sources of information when preparing this section:

- Major new Government policy or legislation affecting the portfolio and the intended results and impacts;
- Portfolio department's mission and/or vision statement; and
- Ministerial statements by portfolio Ministers.

3.2 Portfolio structure and outcomes

The template for this figure can be found in the "Figure 1" tab of the Excel Tables workbook (Attachment B).

This figure is a graphical representation of the portfolio structure and the responsible Ministers. It should clearly indicate the names and titles of the
Ministers, the portfolio department(s) and Secretary, and the other portfolio entities and their Chief Executive Officers (CEOs), as well as the outcome statements for each entity.

All portfolio entities covered by the Public Governance, Performance and Accountability (PGPA) Act 2013 are to be included in the figure.

Portfolios should include the current outcome statements for each entity as agreed by the Minister for Finance. The outcome statement(s) included in Figure 1, and throughout the PB Statement, must be consistent with the Appropriation Bills.

**Source of information:**


### 3.3 Portfolio resources made available in the Budget year

The template for this table can be found in the “Table 1” tab of the Excel Tables workbook (Attachment B).

This table shows the total new resources provided to the portfolio in the 2015-16 Budget year, broken down by entity and appropriation source. The table does not include amounts carried forward, nor opening special account balances.

The figures shown in this table should be consistent with figures reported in the Entity Resourcing Table in Budget Paper No. 4 (BP 4) and the Appropriation Bills, noting that some special accounts reported in BP4 may contain amounts considered special public money, whilst Table 1 should exclude special public moneys.

It is recommended that this table be completed by the portfolio department once all entities in the portfolio have completed their Entity resource statements (Table 1.1).

**Source of information:**

- The information to be included in this table can be sourced by running the following CBMS report for the 2015-16 Budget year:
  - BEAM Reports > Appropriation Bills > Appropriation Bill Report > Agency Resourcing Table

- The figures included for each entity must match the figures included in the Appropriation Bills and in the 'Entity Resourcing Table’ in BP 4 as they are the authoritative documents. Using the figures from CBMS will ensure consistency as it is the central repository of budget information used for the production of the Appropriation Bills and Budget Papers.

- The “Receipts” column in the Portfolio resources table is the sum of funds received from other sources, through section 74 PGPA Act Retained Revenue Receipts (or receipts from independent sources for corporate entities, i.e. corporate Commonwealth entities and Commonwealth companies) and non-appropriated credits to entity special accounts. These figures appear under the “Receipts” and “Special accounts” columns in the Entity Resourcing Table of BP 4, respectively.
• The “Special” column in the Portfolio resources table is the sum of the “Special appropriations” columns in the Entity Resourcing Table in BP 4.

• Payments to corporate entities that appear in the Bills are not to be shown in the portfolio department’s appropriation lines. They are to be reported by the corporate entity as “Departmental appropriations” under “Bill No. 1”, not in the receipts column.

• The Portfolio total line will equal the Portfolio total line in the Entity Resourcing Table in BP 4. Transfers between agencies within the Portfolio are to be netted out (e.g. section 74 Retained revenue receipts from one entity to another) to show an accurate picture of the resources made available to the portfolio.
4. Entity Overview and Resources section

This section of the PB Statements is aimed at providing the reader with an overall picture of each entity’s objectives and resources across the budget and forward estimates period.

This section should also provide the reader with an overall picture of each entity’s strategic direction and planned performance, as well as a summary of new government measures.

There are four components to this section which together link the entity strategy with the resources available.

Components of Section 1: Entity overview and resources

- Strategic direction statement;
- Entity resource statement (including Table 1.1);
- Budget measures (Table 1.2); and

4.1 Strategic direction statement

This section should be no longer than two pages.

The Strategic direction statement should outline an entity’s anticipated strategic direction for the budget and forward years.

The Strategic direction statement should describe an entity’s outcome statement(s) in a strategic, relevant and concise manner, as well as outline the broad strategies the entity intends to adopt in order to achieve these outcomes, and the planned results and goals to be achieved. The statement should also outline how these outcome statements contribute to the achievement of whole-of-government strategic priorities and outcomes.

The statement should identify major ongoing functions, new functions (or loss of functions) and measures allocated to the entity, and any significant challenges that will impact on the entity’s performance against its outcome(s) over the medium term.

The statement should be reasonably high level – a detailed discussion of operational issues can be covered in the entity’s corporate plan or on its website.

4.2 Entity resource statement

The template for this table can be found in the “Table 1.1” tab of the Excel Tables workbook (Attachment B). There is a template for non-corporate Commonwealth entities (coloured green) and a template for corporate Commonwealth entities and Commonwealth companies (coloured red).
The Entity resource statement provides a summary of all resources available to the entity over the budget year which it may draw upon in achieving government outcomes and objectives.

It provides a breakdown of these resources by funding source, and includes undrawn and unspent amounts from prior years as well as the balances of special accounts, but excludes amounts subject to quarantine or reduction.

Entities with special accounts will need to ensure amounts transferred to and from the special accounts and other funding sources are netted off so they are not double counted.

The “Actual Available Appropriation” column shows the estimated amount available to the entity in the 2014-15 financial year.

**Prior year annual appropriation balances**

Please note that as a result of the *Statute Stocktake ( Appropriations) Act 2013* and the *Omnibus Repeal Day ( Autumn 2014) Act 2014*, all unspent annual appropriations (both for ordinary annual services and for other services) from 2011-12 or earlier were extinguished.

Annual appropriations relating to the 2012-13 and 2013-14 financial years will be repealed two years after the end of the relevant financial years through future Omnibus Repeal Day Bills.

Amounts which have been extinguished should be excluded from the calculation of prior year balances for the purposes of the Entity resource statement.

A separate Estimates Memorandum will be issued on the repeal of prior year annual appropriations.

**Quarantines**

Under the *PGPA Act*, the Minister for Finance is able to quarantine amounts under section 51. These quarantined amounts should not be recognised as appropriations in Table 1.1 nor in the financial statements.

**Source of information:**

- Appropriation information in this table must be sourced from CBMS and an entity’s annual reports, and should be consistent with information captured in an entity’s financial management information system (FMIS).

- The majority of the information can be sourced by running the following reports from CBMS:
  - BEAM Reports > Appropriation Bills > Appropriation Bill Report > Agency Resourcing Table
  - BEAM Reports > Appropriation Bills > Appropriation Bill Report > Appropriation Bill 1
  - BEAM Reports > Appropriation Bills > Appropriation Bill Report > Appropriation Bill 2
  - BEAM Reports > Appropriation Bills > Appropriation Bill Report > Estimated Expenses Special Appropriations
• BEAM Reports > Appropriation Bills > Appropriation Bill Report > Estimated Cash Flows and Balances for Special Accounts

• ACM Reports > Appropriation Balance Report

• BEAM Reports > Appropriation Bills > AAA Audit Report – select the current financial year only to get the “Actual available appropriation” figure available on that day. This amount may not include amounts to be appropriated through Appropriation Bill (Nos. 5 and 6) 2014-15 nor Advances to the Minister for Finance.

• The “prior year appropriation” rows should reflect unspent/undrawn appropriations available at the start of the financial year (i.e. the closing balance of the previous year).

• For the "Actual available appropriation" column, this will be the closing unspent appropriation balance from the entity’s 2013-14 annual report.

• For the "Estimate of prior year amounts" column, this will be the forecast closing unspent appropriation balance as at the end of the 2014-15 year.

• Entities can also check unspent, undrawn balances by running the Appropriation Balance Report from CBMS for the relevant financial year and referring to the “Available – Hard Limit” lines. The “Available – Hard Limit” lines show how much of the amount which is still available to the entity but has yet to be drawn down.

• Where there are unspent equity injections and Administered Assets and Liabilities appropriations available, they should also be shown in Table 1.1 as a separate line item.

• The “Departmental appropriation” row should reflect the amount appropriated to the entity in the relevant year. This figure will be made up of:

  - Amounts appropriated through Appropriation Acts (Nos. 1, and 3) and Appropriation Bill (No. 5)
  - Advances to the Minister for Finance (AFM)
  - +/- section 75 transfers as a result of Machinery of Government changes
    - administrative quarantines made by Finance
    - any formal reductions in appropriation made by the Minister for Finance under s51 of the PGPA Act (such as for foreign exchange movements, savings measures and other quarantines).

• Amounts under the “Actual Available Appropriation” column can be sourced by running the AAA Audit Report (which provides an estimate at a point in time) and including any amounts yet to be appropriated, e.g. amounts through Appropriation Bill (No. 5) and AFMs.

• The “s74 Retained revenue receipts” row should reflect the entity’s forecast Receipts from Independent Sources. These figures should be sourced from the "Receipts" columns in the Entity Resourcing Table report from CBMS.

• The “Administered expenses” rows should be taken from the Appropriation Bill 1 report from CBMS and match the “outcome” and “payments to corporate entities” splits outlined in the Bill.
For portfolio departments, the Appropriation Bill 1 report should be run at the portfolio rather than entity level.

Amounts under the “Actual Available Appropriation” column can be sourced by running the AAA Audit Report (which provides a point-in-time figure) and including any amounts yet to be appropriated, e.g. amounts through Appropriation Bill (No. 5) and AFMs.

This amount can also be sourced from the Appropriation note of the entity’s 2013-14 annual report, under the “Appropriations applied” column.

The “Other Services” rows should be taken from the Appropriation Bill 2 report from CBMS.

For portfolio departments, the Appropriation Bill 2 report should be run at the portfolio rather than entity level.

Amounts under the “Actual Available Appropriation” column can be sourced by running the AAA Audit Report (which provides a point-in-time figure) and including any amounts yet to be appropriated, e.g. amounts through Appropriation Bill (No. 5) and AFMs.

The “Special Appropriations” rows should reflect expenses expected to be incurred in relation to special appropriations. These figures should match the figures published in BP 4 (in both the Special Appropriations table and also the Entity Resource Table), and be sourced from the Estimated Expenses from Special Appropriations report from CBMS.

The “Special Accounts” rows should reflect the opening balances and receipts for all special accounts managed by the entity. These figures should be drawn from the “Estimated Cash Flows and Balances for Special Accounts” report from CBMS. Special public moneys held in “Services for Other Entities and Trust Moneys” (SOETM) accounts should be excluded from this figure as they do not constitute funds available to the entity.

The “Third Party Payments” information will be drawn from entities’ own records and should be agreed with the relevant entity. These figures should be prepared on a consistent basis, i.e. all resourcing (cash payments/appropriations received) or all expenses (and appropriation revenue), and the reader should be able to reconcile figures between entities.

4.3 Budget measures
The template for this table can be found in the “Table 1.2” tab of the Excel Tables workbook (Attachment B).

The Budget measures section primarily highlights new government decisions taken since the tabling of the last set of Appropriation Bills, generally at Additional Estimates. It includes measure titles and estimates for the current financial year (2014-15), the budget year (2015-16) and forward years (2016-17 to 2018-19).

For completeness, all measures need to be reported at the entity level in a Portfolio statement, i.e. either the PB Statements, Portfolio Additional Estimates Statements (PAES), Portfolio Supplementary Estimates Statements (PSES), or Portfolio Supplementary Additional Estimates Statements (PSAES).
This complements the whole-of-government public reporting of all measures in either Budget Paper No. 2 (BP 2) or the Mid-Year Economic and Fiscal Outlook (MYEFO) and ensures a clear-read of Government decisions to entity level across key budget publications.

All details of 2015-16 Budget measures must match the final measures list provided by your AAU before being reported in Table 1.2. Measure figures are to be reported on a fiscal balance basis as this is the basis on which BP No.2 is prepared.

The wording for cross Portfolio measures should be the same in each PB Statements affected by the measure. To increase transparency, where an entity is not the lead entity in a measure package, they are required to name the lead entity in a footnote to the measure to allow easy cross reference to the measure description in BP No.2 and across PB Statements. This should be done with the following text:

The lead entity for measure xxxxxxx is entity xxxxxxx. The full measure description and package details appear in Budget Paper No. 2 under the xxxxxxx portfolio.

Table 1.2 is split into two parts – one part covers measures which will be announced in the 2015-16 Budget, and the other part covers those announced since the previous Budget which have not previously been reported in Portfolio Statement, such as those announced in an Economic Statement, in a Pre-Election Economic and Fiscal Outlook or MYEFO and which were not included in the 2014-15 PAES.

The most common reasons for excluding measures from the 2014-15 PAES are:

- the measure did not require additional funding through Appropriation Bills (Nos. 3 and/or 4); or

- the measure was for savings, or there was no additional appropriation required as the entity’s spending measures were fully offset by savings measures; or

- the measure related to future year (i.e. 2015-16 or later years); or

- the measure related to an alternative source of funding, such as a special appropriation and/or special account.

The Budget measures published in the first part of Table 1.2 should match the measures as printed in BP No.2. Where a measure was reported in PAES and also appears in BP 2, it does not need to be reported again in the PB Statements. Measures in BP No.2 will also include those that were Decisions taken but not yet announced at MYEFO.

Measures in the second part of Table 1.2 should match the measure as printed in the relevant economic statement/budget paper.

**Measure reversals**

Where a measure reversal will be reported in BP 2, the measure reversal needs to be reported in Part 1 of the measures table.

Where a measure reversal has been reported in MYEFO, but has not been reported in PAES, the reversal needs to be reported in Part 2 of the measures table.

Measure reversals reported in either Part 1 or 2 of the measures table need to be reported on the following basis:
• where it is a full reversal, the measure should include dashes in fiscal impact (as zero net fiscal impact); and
• where it is a partial reversal, the measure should reflect the final amount to be appropriated, i.e. the difference between the initial measure and the partial reversal.

**Example – Reporting Measure Reversals**

Entity X has two measures that were announced in an Economic Statement, the Pre-Election Economic and Fiscal Outlook or the Mid-Year Economic and Fiscal Outlook:

<table>
<thead>
<tr>
<th>Measure Title</th>
<th>2014-15 $m</th>
<th>2015-16 $m</th>
<th>2016-17 $m</th>
<th>2017-18 $m</th>
<th>2018-19 $m</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Measure</td>
<td>$2</td>
<td>$4</td>
<td>$6</td>
<td>$8</td>
<td>$10</td>
</tr>
<tr>
<td>Y Measure</td>
<td>$1</td>
<td>$2</td>
<td>$3</td>
<td>$4</td>
<td>$5</td>
</tr>
</tbody>
</table>

These measures were subsequently reversed at Budget (fully or partially) through the announcement of the following measure reversals:

<table>
<thead>
<tr>
<th>Measure Title</th>
<th>2014-15 $m</th>
<th>2015-16 $m</th>
<th>2016-17 $m</th>
<th>2017-18 $m</th>
<th>2018-19 $m</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Measure – reduction</td>
<td>$(1)</td>
<td>$(2)</td>
<td>$(3)</td>
<td>$(4)</td>
<td>$(5)</td>
</tr>
<tr>
<td>Y Measure - cessation</td>
<td>$(1)</td>
<td>$(2)</td>
<td>$(3)</td>
<td>$(4)</td>
<td>$(5)</td>
</tr>
</tbody>
</table>

Entity X should report the following in their PB Statements that shows the net effect of these full/partial reversals, with an explanatory footnote to provide context:

**Table 1.2: Entity 2015-16 Budget Measures**

**Part 1: Measures announced since the 2014-15 MYEFO**

<table>
<thead>
<tr>
<th>Programme</th>
<th>2014-15 $'000</th>
<th>2015-16 $'000</th>
<th>2016-17 $'000</th>
<th>2017-18 $'000</th>
<th>2018-19 $'000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense measures</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>X Measure (a)</td>
<td>1.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Administered expenses</td>
<td>1,000</td>
<td>2,000</td>
<td>3,000</td>
<td>4,000</td>
<td>5,000</td>
</tr>
<tr>
<td>Total</td>
<td>1,000</td>
<td>2,000</td>
<td>3,000</td>
<td>4,000</td>
<td>5,000</td>
</tr>
<tr>
<td>Y Measure (b)</td>
<td>2.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Administered expenses</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Total</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

(a) This measure was originally announced in the 20XX Economic Statement/20XX Pre-Election Economic and Fiscal Outlook/2014-15 Mid-Year Economic and Fiscal Outlook (whichever applies) and has been partially reversed by a reduction measure announced in the 2015-16 Budget. The above financial figures reflect the current net fiscal impact of the measure.

(b) This measure was originally announced in the 20XX Economic Statement/20XX Pre-Election Economic and Fiscal Outlook/2014-15 Mid-Year Economic and Fiscal Outlook (whichever applies) and has been fully reversed by a cessation measure announced in the 2015-16 Budget. The above dashes reflect that the measure has no fiscal impact as it has ceased.
Decisions taken but not yet announced

Where a measure has been published in an economic statement as a “Decision taken but not yet announced” (DTBNYA), it should be published in the next available budget statement.

- Where the measure has been announced by the Government, the measure should be listed in Table 1.2 with its full measure title and associated costs.

- Where the measure has not been or will not be (e.g. for national security reasons) announced publicly at the next budget statement, the costs for measure should be included as part of the “Decisions taken but not yet announced” total line at the bottom of Table 1.2. The measure title should not be listed separately.

The exception is where the entity is preparing their PAES and the measure does not require funding through Appropriation Bills (No. 3, 4, 5 or 6) – in this case, the measure can be omitted from the PAES and published in the next PB Statements.

Measures with indicative costs

Where measures are published in an economic statement with indicative costs, these measures should be listed in Table 1.2 where costs for each affected entity are known.

- Once final costs have been agreed, entities may republish the measure in Table 1.2 of the PAES or PB Statements, and include a footnote stating that the measure was previously published in BP2/MYEFO/the relevant economic statement and the costs shown are now final.

- For cross-portfolio measures where final costs have now been agreed for each entity, the measure should be listed in Table 1.2 with the final agreed costs, with a footnote noting that it is a cross-portfolio measure previously published in BP2/MYEFO/the relevant economic statement, and naming the lead entity.

Machinery of government changes

Where there are Machinery of Government changes, the gaining entity should publish any new measures relating to the function(s) being gained.

For further information on showing Machinery of Government changes in the PB Statements, please refer to Section 6.16 of this guidance.

Source of information

- Figures should be presented on a fiscal balance basis – to confirm the correct amounts, please refer to the costing agreement letters provided by your AAU.

- Information to be included in this table should be taken from estimates adjustments for measures (i.e. those entered against the reason code “Government decision or measure”) in CBMS.

- Titles of measures are to be confirmed against the final agreed measures list provided by the Department of the Treasury (or the Department of Finance).
5. Outcomes and planned performance section

No changes will be made to the performance reporting requirements for the 2015-16 PB Statements. Further guidance will be issued in due course on the corporate plan requirements.

For advice on changing outcome statements or programmes, please contact your Agency Advice Unit in Finance in the first instance.

For advice on performance reporting in the PB Statements, please contact the Performance Reporting and Planning Branch in Finance (PMRAPerformanceframework@finance.gov.au).

The Outcomes and planned performance section (Section 2) details the outcomes and programmes of an entity, its resourcing, deliverables and performance information.

The first part of Section 2 addresses the outcome statement level of reporting, with a focus on the Outcome strategy statement and an Outcome expense table, split by programme.

The 2015-16 PB Statements are used to provide structured reporting of an entity’s performance, focusing primarily on programmes. The reporting structure allows entities to demonstrate their performance in a logical and consistent manner, indicating to the public and the Parliament the resourcing provided and the deliverables produced.

As outlined in the Commonwealth’s Outcome Statements and Approval Policy (Outcomes Policy), outcome statements articulate Government objectives and serve three main purposes within the financial framework. They:

1. explain the purpose for which annual appropriations are approved by the Parliament for use by entities;
2. provide a basis for budgeting and reporting against the use of appropriated funds; and
3. measure and assess entity and programme non-financial performance in contributing to Government policy objectives:

For information on amending an entity’s existing outcome statement(s) or programmes, please refer to the Outcomes policy and Programmes policy available on the Finance website: http://www.finance.gov.au/resource-management/performance/

Entities are required to report Key Performance Indicators (KPIs) for their programme objectives. If a KPI changes from last year’s PB Statement or Portfolio
Additional Estimates Statements (PAES), entities should footnote in the KPI table a summary of the change and whether they have met the previous KPI at the programme level. In order to assess programme performance over time, consistency in KPI reporting is encouraged.

Components of Section 2: Outcomes and planned performance

- Outcome strategy statement
- Changes in entity outcomes and programmes (where applicable – including Table 2).
- Outcome expense statement (including Table 2.1 Budgeted expenses for Outcome X)

5.1 Outcome strategy statement

The Outcome strategy statement should be no longer than three quarters of a page in length.

When completing the Outcome strategy statement, entities may wish to indicate the timeframes relevant to the outcome and its supporting programme(s) (i.e. if outcomes are focusing on a 10-year timeframe then the strategy should take this into account). Entities may also wish to include evidence of actual and planned progress against their Outcome strategy statement to assist in explaining how it is being implemented.

The circumstances of the target group (as addressed by the Outcome strategy statement’s intended result) should be outlined with reference, where possible, to the evidence source to be used for measurement purposes (for example, Australian Bureau of Statistics (ABS) census data etc).

5.2 Outcome expense statement

The template for this table can be found in the “Table 2.1” tab of the Excel Tables workbook (Attachment B). There is a template for non-corporate Commonwealth entities (coloured green) and a template for corporate Commonwealth entities and Commonwealth companies (coloured red).

The Outcome expense statement (Table 2.1) provides the reader with further detail of an entity’s programmes and expenses, in particular, the proposed use of appropriations and links this expenditure to the entity’s financial statements (specifically the income statement). It provides a breakdown of total expenses for each outcome by funding source. This statement complements the Entity resource statement (Table 1.1), which in contrast provides a summary of funding sources but not forecast expenditure.

Entities are to report outcomes on an expenses basis, for each programme. Programme expenses are to be broken down further into the respective funding source/appropriation type. A separate table should be prepared for each outcome.

The total budgeted expenses for all outcomes must equal the aggregated of total Departmental and Administered expenses as outlined in the Comprehensive income statement (Table 3.2.1) and Schedule of budgeted income and expenses administered on behalf of Government (Table 3.2.7).
Table 2.1 also provides an estimate of Average Staffing Levels (ASL) by outcome for the budget and prior year. The total ASL figures across all outcomes should reconcile with the ASL figures to be published in BP 4.

A summary of the relationship between Table 2.1, Table 2.2 (Programme expenses) and the income statements is provided below:

Where amounts are drawn down from an annual or special appropriation and credited to a special account, please ensure that the expenses are not double counted, for example, by netting off the transfer from an annual appropriation to a special account and only showing the final expenses against the special account.

**Source of information**

- The following report from CBMS should be used to prepare Table 2.1:
  - BEAM Reports > Annual Estimates > Programme Report.
    - Select “gross expenses” in the Programme Account field and choose either “Departmental” or “Administered” as the control type. The “Inter General Government Transactions” check box should be left unticked when running this report.

- Administered programme totals across all outcomes must match the gross expenses total in the Administered Programme Report from CBMS, as well as the ”Total expenses administered on behalf of Government” line in the Schedule of budgeted income and expenses administered on behalf of Government (Table 3.2.7)

- Departmental programme totals across all outcomes must match the gross expenses total in the Departmental Programme Report from CBMS, as well as the “Total expenses” line in the Comprehensive income statement (Table 3.2.1).
For the "programme support" row in Table 2.1, this is not usually reported in CBMS as a separate programme. Entities are to use the gross expense figure for 'Departmental—Other'.

Total expense figures for special appropriations must match those reported in BP 4 in the "Estimated Expenses from Special Appropriations" table.

The figures included in the "Programme expenses" section which follows the Outcome Expense section must reconcile to the totals included in the Outcome expenses statement by programme, appropriation type and Administered/Departmental classification.

Entities which maintain a special account(s) will need to ensure these amounts are not double counted at the outcome expense level. Special accounts which hold "special public monies" will not flow through to the Programme report in CBMS and should not be included in the Outcome Expense statement.

The "Expenses not requiring appropriation in Budget year" line is to be used by entities where there is a government policy not to fund those expenses; the funding has been provided in a prior year but the expense will be incurred in the current year; or the expenses reflect the usage of services provided free of charge.

For example, depreciation expenses which the Government has provided a separate capital budget/Collection Development Acquisition Budget should be shown in this line, along with expenses associated with audit services provided by the Australian National Audit Office.

Please note: The Entity resource statement (Table 1.1) focuses on funding/appropriations whereas the Outcome expense statement (Table 2.1) focuses on expenditure (expenses). These are not always the same amounts as differences can exist between appropriation amounts and the total expenses recognised against programmes.

Items which do not or will not involve a cash flow impact (such as write-offs, asset devaluations and bad debt expenses) are excluded from the calculation of appropriations, and hence the Entity resource statement (Table 1.1). As such, these expenses (i.e. expenses with no appropriation impact) are to be reported as "Expenses not requiring appropriation" at the appropriate line in Table 2.1 to show the total expenses for each programme, and to allow for reconciliation with the appropriation view of entity resources, the programme report in CBMS and the entity's income statement(s).

Average staffing level figures across all outcomes are to be sourced from the entity's own records, and match the figures to be published in BP 4. Please refer to the latest Estimates Memorandum on Average Staffing Levels (ASL) for more information.

5.3 Programme reporting

The aim of programme reporting is to provide transparent and consistent information to Parliament and the public about Government activities. The Commonwealth Programmes Policy and Approval Process (Programme Policy) sets

The Programme Policy states that “in addition to resourcing information, entities are required to provide details of the programme’s objectives and non-financial performance, including the deliverables and key performance indicators for each programme.” This information is required to provide an understanding of a programme’s purpose, how much funding it requires, what it will deliver to the community or specific target group and a measure of its effectiveness.

Deliverables and key performance indicators (KPIs) are two different concepts. The Performance Information and Indicators policy paper includes the following definitions:

1. **Deliverables are:**
   - Produced by the programme in meeting its objective; and
   - Tangible, quantifiable products of a programme (e.g. payments or a database).
2. **KPIs:**
   - Assist in determining if a programme is achieving its objectives. KPIs should measure the effectiveness and efficiency of the programme and clearly measure the programme’s success, particularly against the intended result of the relevant outcome statement.

Please note: ‘Other Departmental’ must not be used as a programme name in the PB Statements. The CBMS allocation line ‘Other Departmental’ should be reported in the PB Statements as:

1. Programme support - where departmental funding supports the delivery of existing Commonwealth Programmes; or
2. A single programme, with the entity name or similar used as the programme name - where departmental funding is not classed as programme support and the funding represents the functions of the entity (e.g. the Productivity Commission reports under a single programme titled ‘Productivity Commission’).

Entities that have a single outcome and single programme do not need to complete the outcome strategy section, as this information should be reflected in the strategic direction statement. These entities will still need to complete the Entity resource statement, Budget expense for outcomes table, and programme information section as these tables detail different information.

**Components of Section 2 (Part 2): Outcomes and planned performance:**

- Programme reporting:
  - Programme objective
  - Programme expenses
  - Programme components (where applicable)
  - Programme deliverables
  - Programme key performance indicators
Presenting linked programmes

Entities are required to report on circumstances where two or more Commonwealth programmes contributed to related objectives by including linked programme information in the PB Statements (note this is not a CBMS requirement).

There are instances across government where programmes from multiple entities contribute to a related government objective. These can be formal linkages (e.g. Memoranda of Understanding, service level agreements or legislation) or less formal links where two programmes address different aspects of the same policy agenda.

Entities may report linked programmes in a variety of ways, for example, they may describe linked programmes in the Outcome strategy statement or Programme objective, or list them as per the example below.

**Example: Linked programmes**

This example depicts how two different entities could show linked programmes in their PB Statements.

<table>
<thead>
<tr>
<th>Entity X: Programme X.X</th>
<th>Entity Y – Programme Y.Y</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Programme X.X:</strong> Xxxxxxx</td>
<td><strong>Programme Y.Y:</strong> Xxxxxxx</td>
</tr>
<tr>
<td><strong>Programme objective:</strong></td>
<td><strong>Programme objective:</strong></td>
</tr>
<tr>
<td>Description of programme objective.</td>
<td>Description of programme objective.</td>
</tr>
<tr>
<td>Linked to: Entity Y - Programme Y.Y</td>
<td>Linked to: Entity X - Programme X.X</td>
</tr>
</tbody>
</table>

5.4 Programme objective

It is good practice that the programme objective is concise. It should typically be no longer than half a page and it should succinctly outline the issue being addressed and results and impacts to be achieved.

A concise programme objective should aim to answer key questions about the purpose of the programme, including:

- What issue/area of need has been identified by government for a specific target group?
- What is known about the issue/area of need?
- What is the scope of the issue/area of need?
- How the programme will achieve its objectives (including linkages to other programmes)?

Entities are to link to Commonwealth programmes in other entities which contribute to similar or closely-related Government objectives.

The linked programme box is to be used where programmes undertaken by multiple entities contribute to the same Government objective. To ensure consistency across government, entities are to seek agreement with the other relevant entities on the
detail included, prior to including the linked programme information. Details such as the relevant entity name (if in another entity), and programme number (i.e. 1.2) should be included in the PB Statements, so that similar details may be easily found within the other entity's PB Statements.

Those entities affected by Federal Financial Relations payments made by Treasury, should expand as necessary the non-financial information provided for the planned performance of these programmes, within the relevant section and also ensure that the affected programmes are linked or cross referenced to the payments made by Treasury within the “linked to” section and where appropriate a footnote under the Programme expense table.

A short sentence to explain the link is also recommended, such as:

- Linked to Treasury Programme 1.10 for Federal Financial Relations National Partnership Agreement on Remote Indigenous Housing; or
- DHS delivers the ABC programme payments on behalf of Entity Y for their GHI programme 1.2.

Where relevant, entities should reference the Council of Australian Government (COAG) agreements that their individual programmes contribute to, and provide the relevant web address for further information.

5.5 Programme expenses

The template for this table can be found in the “Table 2.2” tab of the Excel Tables workbook (Attachment B).

This table provides a breakdown of programme expenses by funding source/appropriation type and item/component as relevant. Programmes are to include prior year and forward year data.

Please note: Total expenses across all programmes are to match total expenses captured in CBMS, and reconcile to total expenses reported in the Outcome expense tables (Table 2.1). Total programme expenses should also reconcile to total expenses reported in the Comprehensive income statement (Table 3.2.1) and the Schedule of Budgeted income and expenses administered on behalf of government (Table 3.2.7).

Where programme expenses relate to transfers to special accounts, the following footnote must be included:

XXXXXX item is credited into the XXXXX Special Account. For full Special Account details see Table 3.1.3.

Departmental expenses in support of programme activities are to be allocated to programme support, indicating the full cost to government of delivering a specific programme. As programme support (and some departmental programmes) will typically include an apportionment of corporate/overhead expenses (in addition to direct costs), a reliable and consistent allocation methodology should be used by agencies to produce accurate information.

Expenses deemed to be programme support and other small departmental items, are likely to be included in the ‘Departmental—Other’ programme. Where these expenses are split between Programme expenses tables, they must, in aggregate, reconcile to the data in CBMS.
Programmes listed in the PB Statement must be consistent with those reported in CBMS. If changes in CBMS programme structures or reallocations are required, they should be completed in CBMS before the Budget estimates update so the PB Statements will match the data in CBMS. Entities should contact their AAUs as soon as practicable to discuss any programme changes.

Where relevant, entities may also wish to include a footnote to relevant tables which explains that the allocation of departmental expenses to programmes is notional only and based on attribution models maintained by entities.

Entities should use the text box in the template to outline very briefly any significant trends or variances in programme expenses for the budget and forward years.

Where amounts are drawn down from an annual or special appropriation and credited to a special account, please ensure that the expenses are not double counted, for example, by netting off the transfer from an annual appropriation to a special account and only showing the final expenses against the special account.

**Source of information**

- The following report from CBMS should be used to prepare Table 2.2:
  - BEAM Reports > Annual Estimates > Programme Report.
    - Select "gross expenses" in the Programme Account field and choose either "Departmental" or "Administered" as the control type. The "Inter General Government Transactions" check box should be left unticked when running this report.
  - Administered expense totals across all programmes must match the gross expenses total in the Administered Programme Report from CBMS, as well as the "Total expenses administered on behalf of government" line in the Schedule of budgeted income and expenses administered on behalf of Government (Table 3.2.7)
  - Departmental expense totals across all programmes must match the gross expenses total in the Departmental Programme Report from CBMS, as well as the "Total expenses" line in the Comprehensive income statement (Table 3.2.1).
    - For the "programme support" row in Table 2.1, this is not usually reported in CBMS as a separate programme. Entities are to use the gross expense figure for 'Departmental—Other'.
  - The figures included in Table 2.2 must reconcile to the totals included in the Outcome expenses statement by programme, appropriation type and Administered/Departmental classification.
  - Entities which maintain a special account(s) will need to ensure these amounts are not double counted at the programme expense level. Special accounts which hold "special public monies" will not flow through to the Programme report in CBMS and should not be included in the Programme expense statement.
  - The "Expenses not requiring appropriation in Budget year" line is to be used by entities where there is a government policy not to fund those expenses; the funding has been provided in a prior year but the expense will be incurred in the current year; or the expenses reflect the usage of services provided free of charge.
• For example, depreciation expenses which the Government has provided a separate capital budget/Collection Development Acquisition Budget should be shown in this line, along with expenses associated with audit services provided by the Australian National Audit Office.

• Please note that the Entity resource statement (Table 1.1) focuses on funding/appropriations whereas the Programme expense statement (Table 2.2) focuses on expenditure (expenses). These are not always the same amounts as differences can exist between appropriation amounts and the total expenses recognised against programmes.

• Items which do not or will not involve a cash flow impact (such as write-offs, asset devaluations and bad debt expenses) are excluded from the calculation of appropriations, and hence the Entity resource statement (Table 1.1). As such, these expenses (i.e. expenses with no appropriation impact) are to be reported as “Expenses not requiring appropriation” at the appropriate line in Table 2.2 to show the total expenses for each programme, and to allow for reconciliation with the appropriation view of entity resources, the programme report in CBMS and the entity’s income statement(s).

5.6 Programme components

The template for this table can be found in the “Table 2.2 Programme Components” tab of the Excel Tables workbook (Attachment B).

Entities are not required to provide reporting below the programme level.

Programme component reporting is a subset of programme level reporting, and programme components can be funded through administered and departmental appropriations. If programme components are used, they should be clearly identified as such and not described as a programme. An example of a programme component could be an item of special public interest or political sensitivity.

Within the programme deliverables and programme key performance indicators (KPIs) information, sub headings for each programme component should be included and the relevant deliverables and KPIs for the specific programme component should also be identified.

Should entities choose to report on programme components, a programme component expense table should be provided for each programme component. The full programme expenses must still be provided in the initial programme expense table (Table 2.2). The itemised sub-set of expenses is then provided for each relevant programme component.

The expenses across all programme components should reconcile to the programme expense tables (Table 2.2) and outcome expense tables (Table 2.1).

5.7 Programme deliverables

The purpose of the Programme deliverables table is to show the goods and services produced and delivered by a programme in meeting its objective.

Entities should use the text box to answer briefly the following questions about the deliverables of a programme:

• What deliverables and services will the programme deliver to achieve its objective?
How will these deliverables and services bring about the desired change to address the objective?

The text in this section should typically be brief and not repeat information included in the Programme objective or KPIs sections.

As outlined in the Commonwealth’s Performance Information and Indicators guidance:

"Deliverables are the tangible, quantifiable products of a programme and include both the direct programme activities, (e.g. payments) and the support activities that deliver and manage the programme. However, agencies should focus on the impacts the programme will be making in the community more so than the support activities.

Some examples of programme deliverables include:

- number of payments/transfers made;
- number of days/hours of a service provided (either provided directly by the entity or through a third party); or
- number of information sessions held/participants."


### 5.8 Programme key performance indicators

Reporting on the KPIs associated with programmes provides stakeholders, including the Parliament, with an indication of progress made towards meeting the objectives of a programme. Entities should aim to select strategic and meaningful programme-level performance indicators.

The KPIs section provides information about the programme-level performance measures that will be used by an entity to assess the achievement of programme objectives. Measures may be quantitative or qualitative in nature. This information, most commonly reported in table form, reports on how the programme delivered against a target for the last Budget, in this case 2014-15, with data also provided about planned targets for the current Budget and forward years, where relevant. In many instances, programmes will have various KPIs due to the complexity or scope of the programme activities. Wherever possible, programme-level KPIs should remain consistent across reporting periods to assist with monitoring the achievement of programme objectives over time.

It is good practice for entities to maintain records of trend information and changes to their KPIs. It is recommended that entities advise their AAU in Finance if there are any changes to their KPIs.

If a KPI changes from last year’s budget or PAES, entities should also include a footnote in the KPI table, a summary of the change and whether they have met the previous KPI at the programme level. If it is likely the KPI will not be achieved, a brief explanation of the reasons should be noted in the PB Statements.

Entities are to use data sources and measurable samples of the relevant target groups to show the impact of the programme, where relevant, and support chosen indicators. The group of indicators chosen for a particular programme should collectively address the objective of the programme.
When setting performance targets within or beyond the forward estimates period, entities are to be conscious of previous years' targets and their progress towards achieving them. Performance targets should not be static; they should evolve with improved practices and methods, and periodically be evaluated and revised to ensure entities are achieving the best possible results in contributing towards their outcomes.

Entities should also detail any programme evaluations planned or which have been recently completed in the text box.
6. Explanatory tables and budgeted financial statements section

The purpose of the Explanatory tables is to provide additional resource information to readers. The Explanatory tables and budgeted financial statements in Section 3 of the PB Statements provide readers with financial accounting information about the entity’s operations over the Budget and three forward years.

Section 3 also provides a linkage between an entity’s forecast resources and its forecast expenditure in achieving its outcomes, and indicates the movements in administered funds, Special Account flows and Indigenous expenditure.

Readers are also able to compare information in the Budgeted financial statements can also be compared to the financial statements published in an entity’s annual report so as to form a view on the financial performance of the entity.

Components of Section 3: Explanatory tables and budgeted financial statements

- Explanatory Tables
  - Table 3.1.1 Movement of administered funds between years
  - Table 3.1.2 Estimates of special account cash flows and balances
  - Table 3.1.3 Australian Government Indigenous expenditure (AGIE)
- Budgeted financial statements
  - Differences in entity resourcing and financial statements
  - Analysis of budgeted financial statements
  - Budgeted financial statements tables
    Departmental:
    - Table 3.2.1: Comprehensive income statement (showing Net Cost of Services) for the period ended 30 June
    - Table 3.2.2: Budgeted departmental balance sheet (as at 30 June)
    - Table 3.2.3: Departmental statement of changes in equity – summary of movement (Budget year 2015-16)
    - Table 3.2.4: Budgeted departmental statement of cash flows (for the period ended 30 June)
    - Table 3.2.5: Departmental capital budget statement (for the period ended 30 June)
    - Table 3.2.6: Statement of asset movements (2015-16)
  - Administered (where applicable):
• Table 3.2.7: Schedule of budgeted income and expenses administered on behalf of Government (for the period ended 30 June)
• Table 3.2.8: Schedule of budgeted assets and liabilities administered on behalf of Government (as at 30 June)
• Table 3.2.9: Schedule of budgeted administered cash flows (for the period ended 30 June)
• Table 3.2.10: Schedule of administered capital budget statement (for the period ended 30 June)
• Table 3.2.11: Statement of administered asset movements (2015-16)
• Notes to the Financial Statements – optional

6.1 Movement of administered funds between years

The template for this table can be found in the “Table 3.1.1” tab of the Excel tables workbook (Attachment B).

The Movement of administered funds between years table (Table 3.1.1) details the amount of unexpended annual administered funding which the entity is seeking to have re-phased or re-profiled to the budget or forward years from the current financial year (2014-15).

To re-phase annual administered funds from previous years to the budget or forward years, entities, through their Portfolio Minister, will need to request a movement of administered funds from the Minister for Finance. Entities should discuss proposed movements with their relevant AAU within Finance prior to the preparation of correspondence from their Portfolio Minister to the Minister for Finance.

In reporting approved movements in Table 3.1.1, entities need to include the outcome under which movements are occurring (as outcomes are the point of appropriation). Where the movement relates to a specific programme, then programme details are to be included.

Source of information

• Information for this table should be sourced from approved movement of funds requests (as detailed in correspondence from the Minister for Finance) and/or adjustments in CBMS against the reason code “Movement of Funds”.

6.2 Estimates of special account flows and balances

The template for this table can be found in the “Table 3.1.2” tab of the Excel Tables workbook (Attachment B).

The purpose of the Special accounts table is to provide more detail on the expected flows in entity special accounts over the budget year, including the estimated payments which will be made from the account and adjustments which are expected over the budget year.

Please note: Accounts which hold ‘Special Public Monies’ (such Services for Other Entities and Trust Monies Special Accounts (SOETM)) do not constitute funds
available to the entity and therefore will not appear in the entity or outcome resource statement, but are still required to be mentioned in this section.

When including special account information, entities are to identify the full title of the legislation or legislative instrument which authorised the creation of each special account.

Special accounts are set up by two means, either:

- in enabling primary legislation, as recognised under section 80 of the PGPA Act, in which case the full legislative title and the appropriate section(s) need to be included; or
- through a determination by the Minister for Finance under section 78 of the PGPA Act, in which case include the title of and the determination number of the legislative instrument.

As some titles will be too long to include neatly in Table 3.1.2, entities can use short titles and include an Acts glossary to detail the full title of the enabling legislation.

All special account figures must be drawn from CBMS. The figures included in the PB Statement must also match those in BP 4.

The estimated opening balance will equal the estimated closing balance for the previous year’s transactions.

The interest equivalency payments data should be consistent between both the FMIS of the entities and the journal entries in CBMS.


6.3 Australian Government Indigenous expenditure

The template for this table can be found in the “Table 3.1.3” tab of the Excel Tables workbook (Attachment B).

All entities which undertake indigenous specific programmes are to include an Australian Government Indigenous expenditure (AGIE) Table in their PB Statements. The AGIE table consolidates Indigenous-specific spending by outcome to provide the reader with an overview of the spending commitments. Details of the expenditure are found in the relevant programme.

Entities are to breakdown their Indigenous specific expenditure by outcome and then by appropriation type, either Bill 1 or Bill 2, special appropriation or other, including section 74 PGPA Act Retained revenue receipts.

Furthermore the table is split by control type (administered or departmental), with comparator figures included to allow year-on-year comparisons. The comparator figures are to be calculated in the same manner as the estimated actual figures included in the entity and outcome resource statements.

It is important that entities include the relevant programme to ensure cross reference with Section 2 of the PB Statements.
6.4 Budgeted financial statements

The Explanatory tables and budgeted financial statements section of the PB Statements provides readers with technical and detailed financial information about the entity’s operations over the budget and three forward years. They also include estimated actual information for the current financial year.

Entities should, to the extent that it is possible in an estimates context, be consistent in preparing their Budgeted financial statements, applying the same accounting assumptions and processes that they used at Budget and expect to use in preparing the financial statements to be included in the 2015-16 Annual Report.


Please note: For administered financial statements, entities should not report an administered appropriation receivable balance. This is consistent with Division 4 of the Financial Reporting Rule available in the link above.

Information in the Budgeted Financial Statements must be sourced from CBMS, with the exception of the Impact of Net Cash Appropriation Arrangements note in Table 3.2.1 and the certain sections of the Capital Budget State (Tables 3.2.5 and 3.2.10) and Asset Movement Table (Tables 3.2.6 and 3.2.11).

For a mapping of accounts in CBMS to lines in the Budgeted financial statements, a PB Statements Mapping workbook can be downloaded from the Knowledge Management section of CBMS under “CBMS Users – Reference Material”.

Budgeted Financial Statements - AASB 1055 Budgetary Reporting

From 2014-15, the accounting standard AASB 1055 Budgetary Reporting requires entities to include budgetary information, the original Budget (from the PB Statements) and revised Budget (from a portfolio statement update, such as the PAES), in their financial statements accompanied with variance explanations. The explanations will be audited by the ANAO as part of their audit of the annual financial statements.

Please note: Entities are reminded of the importance of maintaining internal documentation in order to substantiate the basis of the estimates included in the PB Statements. Appropriate documentation would include CBMS reconciliations, CFO sign-offs and Budget allocation authority.

Budget information is required for the following:

- departmental primary financial statements: Statement of comprehensive income, Balance sheet, Statement of changes in equity and Cash flow statement; and
- administered schedules: Administered schedule of comprehensive income, Administered schedule of assets and liabilities and Administered schedule of cash flows.

Budget information to be included in entities’ 2014-15 financial statements is to cover:
original Budget: the Budget numbers published in the entity’s 2014-15 PB Statements for the 2014-15 financial year (required under AASB 1055); and

revised Budget: Revised Budget numbers for the 2014-15 financial year, as published in the entity’s 2015-16 PB Statements (required by Finance).

Prior year budget comparatives are not required.

Entities will be required to explain major variances:

• original Budget against Actuals;
• revised Budget against Actuals; and
• original Budget against revised Budget.

The financial statements template and note disclosures will be developed as part of the 2014-15 PRIMA Forms of Financial Statements and related financial reporting guidance. Entities should note that the Commonwealth already reports Budget numbers in its consolidated financial statements; this should be regarded as a working template for possible disclosures.

AASB 1055 Budgetary Reporting requirements do not replace current Budget reporting requirements.

Entities are reminded that PB Statement numbers must reconcile with those in CBMS.

Entities which prepare their financial statements on a consolidated basis will also be required to prepare their budgeted financial statements on the same basis.

Questions or concerns relating to the application of AASB 1055 to entities’ financial statements can be directed to the Accounting Policy Team (accountingpolicy@finance.gov.au).

6.5 Departmental comprehensive income statement (showing net cost of services)

The template for this table can be found in the “Table 3.2.1” tab of the Excel Tables workbook (Attachment B).

This statement depicts the entity’s estimated income and expenses in relation to its departmental operations over the financial year.

Source of information

The following report from CBMS should be used to prepare Table 3.2.1:

• BEAM Reports > Annual Estimates > Primary Statements Report - select “Departmental” as the control type, and “Income Statement” as the stream type.

• In preparing the “Note: Impact of Net Cash Appropriation Arrangements”, please refer to the similar note at the bottom of the CBMS Income Statement and also refer to Finance Brief 39 on what figures should be shown in the “Depreciation/amortisation expenses previously funded through revenue appropriations” line. Finance Brief 39 is available on the Finance website: http://www.finance.gov.au/publications/financebriefs/finance-brief-39.html.
6.6 **Budgeted departmental balance sheet**

The template for this table can be found in the “Table 3.2.2” tab of the Excel Tables workbook (Attachment B).

This statement depicts the entity's estimated assets and liabilities in relation to its departmental operations at the end of the financial year.

**Source of information**

The following report from CBMS should be used to prepare Table 3.2.2:
- BEAM Reports > Annual Estimates > Primary Statements Report – select “Departmental” as the control type and “Balance Sheet” as the stream type.

6.7 **Departmental statement of changes in equity**

The template for this table can be found in the “Table 3.2.3” tab of the Excel Tables workbook (Attachment B).

This statement depicts the forecast movement in the entity's equity position over the financial year (i.e. the change in the Government's ownership interests in the entity).

**Source of information**

The following report from CBMS should be used to prepare Table 3.2.3:
- BEAM Reports > Annual Estimates > Equity Movement Table Report – select “2015-16” as the financial year and “Departmental” as the control type.

6.8 **Budgeted statement of cash flows**

The template for this table can be found in the “Table 3.2.4” tab of the Excel Tables workbook (Attachment B).

This statement depicts the entity's estimated cash flows over the financial year.

**Source of information**

The following report from CBMS should be used to prepare Table 3.2.4:
- BEAM Reports > Annual Estimates > Primary Statements Report – select “Departmental” as the control type and "Cashflow" as the stream type to generate the agency-entered cash flow statement.
- Where entities would prefer to use the system-generated cash flow, please select "Cashflow – system derived" as the stream type.

6.9 **Departmental capital budget statement**

The template for this table can be found in the “Table 3.2.5” tab of the Excel Tables workbook (Attachment B).

This statement outlines the entity's capital appropriations that will be provided through Appropriation Bills (No.1 and 2) and the purpose for which they were
provided (either to purchase assets, or for departmental supplementation), compared to their forecast capital expenditure.

**Source of information**

The following report from CBMS should be used to prepare Table 3.2.5:

- BEAM Reports > Annual Estimates > Capital Budget Statement – select “Departmental” as the control type.

- Information to be included in the “Reconciliation of cash used to acquire assets to Asset Movement Table” should be sourced from the cash flow statement (Table 3.2.4) and the entity’s FMIS.

**6.10 Departmental statement of asset movements**

The template for this table can be found in the “Table 3.2.6” tab of the Excel Tables workbook *(Attachment B)*.

This statement outlines the movements in the entity’s asset holdings, such as through the acquisition of new or replacement assets, disposals, revaluations or depreciation.

**Source of information**

The following report from CBMS should be used to prepare Table 3.2.6:

- BEAM Reports > Annual Estimates > Asset Movement Table Report – select “2015-16” as the financial year and “Departmental” as the control type.

- Information to be included in the “Estimated expenditure on new or replacement assets” should be consistent with information included in an entity's Departmental Capital Management Plan and information contained in their FMIS.

**6.11 Schedule of budgeted income and expenses administered on behalf of Government**

The template for this table can be found in the “Table 3.2.7” tab of the Excel Tables workbook *(Attachment B)*.

This statement depicts the entity’s estimated income and expenses in relation to its departmental operations over the financial year.

**Source of information**

The following report from CBMS should be used to prepare Table 3.2.7:

- BEAM Reports > Annual Estimates > Primary Statements Report - select “Administered” as the control type, and “Income Statement” as the stream type.
6.12 Schedule of budgeted assets and liabilities administered on behalf of Government

The template for this table can be found in the “Table 3.2.8” tab of the Excel Tables workbook (Attachment B).

This statement depicts the estimated assets and liabilities the entity administers on the Government's behalf at the end of the financial year.

Source of information

The following report from CBMS should be used to prepare Table 3.2.8:

- BEAM Reports > Annual Estimates > Primary Statements Report – select “Administered” as the control type and “Balance Sheet” as the stream type.

6.13 Schedule of budgeted administered cash flows

The template for this table can be found in the “Table 3.2.9” tab of the Excel Tables workbook (Attachment B).

This statement depicts the estimated cash flows over the financial year in relation to the entity's Administered activities.

Source of information

The following report from CBMS should be used to prepare Table 3.2.9:

- BEAM Reports > Annual Estimates > Primary Statements Report – select “Administered” as the control type and “Cashflow” as the stream type to generate the agency-entered cash flow statement.

- Where entities would prefer to use the system-generated cash flow, please select “Cashflow – system derived” as the stream type.

6.14 Schedule of administered capital budget statement

The template for this table can be found in the “Table 3.2.10” tab of the Excel Tables workbook (Attachment B).

This statement outlines the Administered capital appropriations that will be provided through Appropriation Bills (No. 1 and 2) and the purpose for which they were provided, compared to forecast capital expenditure on Administered assets.

Source of information

The following report from CBMS should be used to prepare Table 3.2.10:

- BEAM Reports > Annual Estimates > Capital Budget Statement – select “Administered” as the control type.

- Information to be included in the “Reconciliation of cash used to acquire assets to Asset Movement Table” should be sourced from the cash flow statement (Table 3.2.9) and the entity’s FMIS.
6.15 Schedule of administered asset movements

The template for this table can be found in the “Table 3.2.11” tab of the Excel Tables workbook (Attachment B).

This statement outlines the movements in the entity’s asset holdings, such as through the acquisition of new or replacement assets, disposals, revaluations or depreciation.

Source of information

The following report from CBMS should be used to prepare Table 3.2.11:

- BEAM Reports > Annual Estimates > Asset Movement Table Report – select “2015-16” as the financial year and “Administered” as the control type.

- Information to be included in the “Estimated expenditure on new or replacement assets” should be consistent with information included in an entity’s Administered Capital Management Plan and information contained in their FMIS.
7. Related issues

7.1 Machinery of government changes
Where transfers of appropriations occur under section 75 of the PGPA Act as a result of Administrative Arrangement Order (AAO) changes, these must be reported in PB Statements and/or PAES.

If section 75 transfers have not been agreed in time to be reported in PB Statements, entities should note in their PB Statements that further details of the AAO changes will be reflected in the next budget statement (i.e. PAES).

Affected entities should use explanatory footnotes to provide more detail and context wherever AAO changes apply.

Portfolio overview
- Entities preparing their 2015-16 PB Statements should include a description of any AAO changes arising since the previous budget statement.
- The 'Portfolio Overview' section of the PB Statements should detail the entities that are gained and/or transferred.

Entity resource statement (Table 1.1)
- The Entity resource statement reflects resourcing available to the entity from all sources for the budget year.
- The Entity resource statement should explain by way of footnote for each affected entity the resourcing impact of functions that are gained and/or transferred, and from/to which entity it was transferred.
- The Third party payments section should also reflect functions transferred between portfolios. Where an entity received/lost functions in a previous financial year (i.e. 2014-15), the entity should include a footnote describing the changes and the amounts transferred.

Gaining entities
These are entities that gain functions under the new AAOs.
- In the “Total estimate 2015-16” column, the entity should report all the resources available to it, including those functions it has gained.
- Where the AAO changes occur part way through the 2014-15 financial year, in the “Actual available appropriation 2014-15 column” the entity should take into account any section 75 transfers that have occurred. In other words, the "Actual available appropriation column should be net of those amounts transferred to/from the entity under section 75.
- Entities should include a footnote to Table 1.1 detailing the effects of the AAO changes.
Transferring entities

These are entities that lose functions under the new AAOs.

- In the “Total estimate 2015-16” column, the entity should report all the resources available to it, excluding those functions it has lost.
- Where the AAO changes occur part way through the 2014-15 financial year, in the “Actual available appropriation 2014-15” column the entity should take into account any section 75 transfers that have occurred. In other words, the “Actual available appropriation column should be net of those amounts transferred to/from the entity under section 75.
- Entities should include a footnote to Table 1.1 detailing the effects of the AAO changes.

Outcome information

Outcome information in Section 2 of the PB Statements should be presented as if the AAOs are formally agreed at the time PB Statements is tabled. Please note that entities should only present those outcome statements that have been agreed by the Minister for Finance (or his delegate) in the PB Statements.

- **Gaining entities** should also provide a note against this outcome informing the reader of the entity previously responsible for the function. Gaining entities may also supplement this information if they wish to explain the expected use of resources for new functions against their existing (unchanged or changed) or newly acquired outcomes.
- **Transferring entities** should apply the principle of reporting on the resources under their control. This means that where functions have not yet transferred, they should continue to report on the outcomes (or parts of outcomes) still within their control. This is depicted in Example 1a below.
- The same comment can be made in relation to the performance information, which should continue to be valid unless changes have been made to programme priorities since the 2014-15 Budget or PAES. In general, performance reporting should be at least maintained when functions are transferred. Hence, gaining entities are encouraged to review performance information previously reported by transferring entities to either maintain or enhance this information.
- Previous year actuals figures reported in Section 2 tables will need to be consistent with CBMS. Gaining entities must not report a value against the previous year Actuals column for new functions that have been transferred as a result of AAO changes that happened after the end of the previous financial year. This is to be reported by the transferring entity, as it was the entity in control of the function during the financial year.
- With regards to reporting the amount for the current year, gaining and transferring entities should follow the relevant financial reporting guidance issued by Finance (http://www.finance.gov.au/resource-management/reporting-accounting/financial-reporting/).
- In respect of the period for which entities should prepare financial statements for a function/activity/programme that has been transferred to another entity:
- the transferring entity should report on that function/activity/programme up to the date of transfer;
- the gaining entity should report on the function/activity/programme from the date of transfer.

This treatment is summarised in Example 1b below.

### Example 1a – Transfer pending, transferring entity still in control

In this example, the transferred function is appropriated $1m each year. If the section 75 transfer has not been agreed at the time of the preparation of the PB Statements, the transferring entity is still in control of the function and is therefore required to report on it in their PB Statements:

<table>
<thead>
<tr>
<th></th>
<th>2014-15 Estimated Expenses $’000</th>
<th>2014-15 Revised Estimated Expenses $’000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gaining entities</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Transferring entity</td>
<td>1,000</td>
<td>1,000</td>
</tr>
</tbody>
</table>

1 In this situation, an explanatory footnote will help clarify the pending nature of the transfer for the reader:

   e.g. [Function] will be transferred from [transferring entity] consistent with the AAO change of [XX Month 20XX]. This revised arrangement will be reflected in the 2015-16 PB Statements.

### Example 1b – Movements agreed and appropriations have transferred

In this example, the transferring and gaining entities have agreed that ¾ of the $1m appropriation will be transferred, and a section 75 determination has commenced that transfers this amount. The remaining $250,000 was used by the transferring entity prior to the transfer. The transferring entity will report ¼ of the 2014-15 appropriation and the gaining entity will report the remaining ¾ of the appropriation in their PB Statements:

<table>
<thead>
<tr>
<th></th>
<th>2014-15 Estimated Expenses $’000</th>
<th>2014-15 Revised Estimated Expenses $’000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gaining entities</td>
<td>-</td>
<td>750</td>
</tr>
<tr>
<td>Transferring entity</td>
<td>1,000</td>
<td>250</td>
</tr>
</tbody>
</table>

1 Explanatory footnotes are to be used to provide more context and detail to transfers and reductions of funding arising from AAO changes. They are to make reference to the other entity to/from where the function transferred:

   e.g. [Function] transferred to/from [gaining/transferring entity] as a result of the AAO change of [XX Month 20XX]. [SX] was transferred via a legislative instrument under section 75 of the Public Governance, Performance and Accountability Act 2013.”

   e.g. ASL numbers have been increased/reduced from [previous number] to [current number] as a result of the AAO change of [XX Month 20XX]. This reflects the transfer of [function] to/from [gaining/transferring entity].
Queries from Parliament

While this represents the minimum reporting requirements, it should be noted, however, that entities affected by AAO changes can expect to receive queries from Parliament on resources up to and including the date of the AAO changes, and should be prepared to answer questions on the resources transferred to, or from them.

Disclosure of resource movements can be best accomplished through explanatory footnotes for the Entity Resource Statement (Table 1.1) and Appropriation Tables (Tables 1.5 and 1.6). Footnoting these tables ensures that Parliament has visibility of major appropriation movements that have been completed, as a result of AAO changes.

As noted above, disclosure must be limited to completed transfers, with any outstanding transfers to be covered by comments to the effect that any outstanding resource transfers are subject to further negotiation between entities.

Reporting of any further AAO changes that are announced later

AAO changes can be announced at any time. This can occasionally be after the preparation of the Appropriation Bills has commenced or after the PB Statements or PAES have been completed but not as yet tabled in Parliament.

If changes are announced so close to the presentation of the Appropriation Bills to Parliament that neither the Bills nor the budget statements can reflect the announced changes, these should be explained in the next budget statements and subsequently in the entity's annual report.

Changes to entity outcomes and programmes for AAOs

Entities whose outcome statements are impacted by recent AAO changes should have their revised outcome statement and programme structures approved by Finance and/or the Minister for Finance before they are reflected in the PB Statements.

Changes to outcomes and programmes cannot be reflected in the PB Statements until approved by the Minister for Finance.

An optional template for showing outcome and programme changes is included in the “Table 2 optional” tab of the Excel Tables workbook (Attachment B). Entities may choose to show outcome and programme changes in an alternative table or pictorial format – the presentation chosen will depend on the scope of the changes.

Should entities choose to use Table 2, it should be included under Section 2: Outcomes and planned performance.

Other useful references

Financial reporting guidance for Commonwealth entities

Implementing Machinery of Government Changes

7.2 Programme and outcome changes

Changes to outcomes and programmes cannot be reflected in the PB Statements until the requisite approval from Finance and/or the Minister has been received.

For information on changing programmes and/or outcomes, please refer to the Outcomes Statements Policy and Approval Process and the Commonwealth Programmes Policy and Approval Process, both available on the Finance website:

An optional template for showing outcome and programme changes is included in the "Table 2 optional" tab of the Excel Tables workbook (Attachment B). Entities may choose to show outcome and programme changes in an alternative table or pictorial format – the presentation chosen will depend on the scope of the changes.

Should entities choose to use Table 2, it should be included under Section 2: Outcomes and planned performance.

7.3 Working with the templates

Saving the files

Do not open and save the files. Use your email programme to save the attachments. For example, using Outlook 2001:
1. Select the email containing the attachments
2. Click File and select Save Attachments

Excel table specifications

The Excel Tables in Attachment B have been formatted to B5 size. Should you need to reformat any of the tables, please use the following specifications:

<table>
<thead>
<tr>
<th>Font name</th>
<th>Arial</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font size</td>
<td>8 pts (colour = Black not automatic)</td>
</tr>
<tr>
<td>Height/width dimensions</td>
<td></td>
</tr>
<tr>
<td>Portrait tables</td>
<td>Width 13.6 cm (13 cm in a shaded cell)</td>
</tr>
<tr>
<td></td>
<td>Height 21 cm</td>
</tr>
<tr>
<td>Landscape</td>
<td>Width 21 cm</td>
</tr>
<tr>
<td></td>
<td>Height 13.6 cm</td>
</tr>
<tr>
<td><strong>Row height</strong></td>
<td></td>
</tr>
<tr>
<td>Text and numbers in the body of table (8 pt font size)</td>
<td>Set row height to 11.25 pts (Table Row Height button on the Treasury ribbon)</td>
</tr>
<tr>
<td>If you need to squeeze a table onto one page, you can reduce the font size in the table to 7.5 pts. Please note that fonts cannot be reduced any smaller than 7.5 pts.</td>
<td>Set row height to 10.5 pts</td>
</tr>
<tr>
<td><strong>Table cell alignment</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Horizontal</strong></td>
<td><strong>Vertical</strong></td>
</tr>
<tr>
<td>Text</td>
<td>Left align</td>
</tr>
<tr>
<td>Numbers</td>
<td>Right align</td>
</tr>
<tr>
<td>Braced column headings</td>
<td>Centre</td>
</tr>
<tr>
<td><strong>Borders</strong></td>
<td></td>
</tr>
<tr>
<td>Colour = Black, hairline weight (first option in list, not the default) (Apply Table Border button on the Treasury ribbon)</td>
<td></td>
</tr>
<tr>
<td><strong>Column width</strong></td>
<td>Be consistent particularly if there are similar tables on the one page</td>
</tr>
<tr>
<td><strong>Blank columns and rows</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Columns</strong></td>
<td>To separate columns where braced headings have been used</td>
</tr>
<tr>
<td><strong>Rows</strong></td>
<td>Set row height to 3 pts (Table Row Height button on the Treasury ribbon)</td>
</tr>
</tbody>
</table>

**Note:** Please use minimal capitalisation. Do not wrap text – if text goes over a column width, please extra text in a new row.

**Formatting an existing table to budget standards**

To create a table to fit into a Budget word document set margins in Excel to match the margins in Word.

**Portrait tables**

1. In Excel from "Page Layout" ribbon select Page Layout > Margins > Custom Margins.
2. Click on the "Page" tab, select "Portrait orientation".
3. Ensure the Scaling is set to 100% normal size.
4. Click on the “Margins tab” and set margins to:
   - Left and right: 3.7
   - Top and bottom: 4.3

**Landscape tables**
1. In Excel from the "Page Layout" ribbon, select Page Layout > Margins > Custom Margins.
2. Click on the “Page” tab, select “Landscape orientation”.
3. Ensure the Scaling is set to 100% normal size.
4. Click on the “Margins” tab.
   - Left and right: 4.3
   - Top and bottom: 3.7

**Setting font and text alignment**
1. Click the select all button in the upper left corner of the worksheet (where the row and column headings meet).
2. 
3. From the “Home” ribbon, on the “Font” tab set font to 8 pts Arial.
4. Select the “Alignment” tab set the Vertical text alignment to “Centre”.

**Row height**
1. Select the rows to be adjusted
2. From the “Home” ribbon, in the "Cells" group select “Format” and then “Row height”.
3. Enter 11.25 and then click OK.

**Tip:** If a table is difficult to fit onto a Word page the row height can be reduced. In Word check the printed page to ensure that numbers and text are not cut off.
Table borders

1. Select the row to contain the ruled line.
2. From the “Home” ribbon, select the “Font” tab.
3. Select the “Border” tab.
4. Select the first weight (first in list) and Colour = Black (note: though the line appears to be broken it will appear as solid when linked in Word.)
5. Click OK.
   
   **Tip:** Only apply borders to the row with the description and values, not the row above or below.

Shading

1. Select the cells to be shaded.
2. Select the “Fill” tab from the “Font” group.
3. Select “More colours”.
4. Select the “Custom” tab.

Indenting text

Use the “Right Indent” button to indent text in columns. Do not create a second column to indent text or use spaces to indent text.
Inserting linked Excel tables into the Word template

The standard for Budget is to link tables and charts from Excel into Word. There are a number of reasons for this:

- When the Excel tables are updated, the Word can be easily updated by pressing the F9 key in Word.
- Placing a linked object into a documents helps to keep the file size smaller. An unlinked object increases the document size.
- When you double click on a linked object in Word you cannot open a copy of the Excel workbook (unless you have access to the Excel file).

To insert a linked Excel table into the Word template:

1. In Excel, format the table to budget specifications (see below).
2. In Excel, select and copy the table.
3. In Word, enter the appropriate heading and apply the Table Heading format to the text.
4. In Word, select “Paste Special”, choose “Paste Link – Excel Object” and click “OK”.
5. In Word, type in the footnotes and other text.
6. In Word lock the links by right clicking the linked table and choosing Linked Worksheet Object > Links and then checking the “Locked” tick box, then click “OK”.

To update linked tables

1. In Excel, open the source workbook to update the table.
2. To update the table, in Word, right click the table and select Linked Worksheet Object > Links. Uncheck the "Locked" tick box, then select update now, then re-check the "Locked" tick box, then click “OK”.
3. If you have not locked the tables, press F9 to update the table in the Word document.

7.4 Preparing the Word template for printing

To prepare the Word template for printing, the links to the Excel template should be broken. To break the links:

1. In Word, click the Office button, then “Prepare” and then “Edit Links to Files”.
2. For each link listed, click “Break Link”.
3. Save the file and if required by your publisher, convert to Adobe PDF format for printing.

7.5 Preparing the Word template for online publication

In order to prepare the Word template for online publication and to ensure they are web accessible, entities will need to re-paste the Excel tables into the Word document in HTML format:

1. In Excel, select and copy the table.
2. In Word, select “Paste Special”, choose “Paste – HTML Format” and click “OK”.
3. Save the file. It is now ready for conversion into Adobe PDF or HTML format by your Web Publishing area.

### 7.6 Web accessibility requirements


The tables for the 2015-16 PB Statements have been reformatted to improve accessibility for users with a disability. Changes to improve the accessibility of the PB Statements include:

- Removal of blank cells and rows so text-to-speech reader software can read tables;
- Merging cells so that entire phrases, titles or sentences appear in the one cell, rather than being split over several lines;
- Using “soft returns” in cells so headings in the electronic version can be read by text-to-speech reader software but headings are formatted correctly in the printed version; and
- More consistent capitalisation so sighted users can differentiate between new cells versus new lines within a cell/row.

**Guide to making accessible soft copy documents**

Entities are responsible for making their documents accessible and it is recommended entities contact their publishing or web teams early to ensure requirements are met.

1. **Content structure — use styles:**

   - Using styles such as heading types, bullet point lists and numbered lists makes it easier for users with disabilities to navigate through a document.
   - Use the styles that are available on the Office ribbon under the Home tab or through the Styles window (Alt+Ctrl+Shift+S), i.e. Heading 1, Heading 2, Heading 3, Heading 4, Normal etc.
   - Use heading styles to apply a logical structure to your document. Headings will allow screen reader users to navigate through the page easily and will make the page more usable for everyone. Use the Outline view to see the hierarchy of styles;
   - **Do not skip any heading level** — this may affect the logical reading order of the document when used by a screen reader.
   - Make a page break to move text to the next page to ensure there is no blank space for screen reader audio.
2. Alternative text:
   - Charts and images all need to have alternative text, this text will be read by a screen reader in a Word file and will remain intact when exported to HTML or PDF.
   - You must always provide an alternative text (ALT Text) description for all non-text objects and should communicate the essential content of the image as efficiently as possible.
   - To enter in ALT text right click on the image, select Format Picture/Shape and then select the ALT text tab to enter in the title and description.

3. Use the accessibility checker:
   - If you wish to check the accessibility of your document or template (see Technique 1, above), Word 2010 offers an "Accessibility Checker" to review your document against a set of possible issues that users with disabilities may experience in your file:
     - Select File > Info; and
     - Under Prepare for Sharing, select 'Check for Issues' > 'Check Accessibility'.

4. Convert Word documents to tagged PDF files
   - Microsoft Office 2010 allows you to create tagged PDF files. If you want to verify the accessibility of the PDF or edit the tags that are created, you will still need Acrobat Professional (your web team can help).
     - Select File > Save As; and
     - Under 'Save as' type: select PDF. Before you save the file, select ‘Options’ and ensure that the 'Document structure tags for accessibility' option is selected.

5. Making Excel tables accessible
   - Because of the complex nature of the Budget tables, it’s difficult to make them accessible using Microsoft Office 2010 features. There are two options to make this content available, Entities can either make the data behind the tables available on their website or they can convert the Excel tables to Word.
     - Further information on developing accessible soft copy documents could be found by contacting the Treasury Publications Team on publicationsteam@treasury.gov.au or (02) 6263 4000.

7.7 Additional guidance on ACM Reports and Appropriation Bills

Appropriation estimates are recorded in CBMS in the BEAM module. The Annual Estimate in BEAM is used to create the Appropriation Bills. When an Appropriation Bill is given Royal Assent and becomes an Appropriation Act, the values are then used as the Appropriation Limits in ACM (also called ‘budgets’). Appropriation limits are treated as "Hard" or "Soft" depending on their outcome requirement.

A "hard limit" is a limit that cannot be exceeded with a drawdown. This is because a hard limit is a legally appropriated amount, adjusted for changes authorised in law such as section 75 transfers as a result of Machinery of Government changes, section
74 retained revenue receipts, quarantines by the Minister for Finance or the Advances to the Minister for Finance.

- For departmental operating appropriations, the hard limit equals the total amount appropriated for the entity.
- For administered operating appropriations, the hard limit is the amount provided for each outcome.

A soft limit is the limit against a portion of the hard limit after it is allocated to a programme (e.g. administered operating) or outcome (e.g. departmental operating). These limits can be exceeded with a drawdown, providing they do not exceed the hard limit. Soft limits can be adjusted on request from agencies (though they generally reflect splits identified in PB Statements/PAES.)
8. Contacts

Department of Finance
In the first instance, entities should contact Finance staff in the relevant AAU with enquiries.

For guidance on the preparation of the PB Statements, entities can contact the Budget Reporting and Framework Team:

Dario Forner   (02) 6215 3408  
Melissa Pan    (02) 6215 3599  BudgetFramework@finance.gov.au  (emails rated up to Protected)
Alex Berry     (02) 6215 3209
Nikki Fitzherbert (02) 6215 3032

For guidance on the production of the Appropriation Bills, the Chief Finance Officer sign off process and outcome changes, entities should contact the Annual Appropriation Team on GARMAnnualAppropriations@finance.gov.au.

For queries regarding performance reporting, please contact the Performance Reporting and Planning Branch (PMRAperformanceframework@finance.gov.au).

For enquiries regarding publication of information on Data.gov.au and the Open Government initiative, please email data.gov@finance.gov.au.

Treasury
Treasury can assist with document formatting issues and links to PB Statements on Budget.gov.au

Publications team (for formatting)
publicationsteam@treasury.gov.au   (02) 6263 4000

Web Content team (for Budget.gov.au links)
webcontent@treasury.gov.au   (02) 6263 4040

CanPrint
It is strongly recommended that portfolio departments contact CanPrint to arrange printing for the PB Statements. If printing is carried out ‘in-house’ or with another printer, entities must liaise with Finance to ensure that cover stock, colour and text is consistent with all other portfolio entities.

It is the responsibility of each portfolio departments to arrange the printing and secure freighting of their PB Statements.
Contact details for CanPrint Communications Pty Ltd are:

Peter Reid and Andrew Brien  
(02) 6295 4450

Address:  
Canprint Communications Pty Ltd  
16 Nyrang Street  
Fyshwick, ACT 2609

**Senate Table Office**

The Senate Table Office requires 120 copies of each PB Statement for Senators. Their contact details are:

Marcus Strkalj  
(02) 6277 3037

Address:  
Room SG 25  
Department of the Senate  
Parliament House  
Canberra, ACT 2600

**Treasury Lockup (House of Representatives, Parliament House)**

The Parliament and Media Budget Lockup is held at Parliament House, and 120 copies should be delivered to Suite RG89 in House of Representatives side of Parliament House.

Kym Harrington (Treasury)  
(02) 6263 3930

Documents Officer, House of Representatives  
(02) 6277 4802
9. Glossary of terms

Activities
The actions/functions performed by entities to deliver government policies.

Actual Available Appropriation
The Actual Available Appropriation indicates the total appropriations available to the entity for 2014-15 as at the 2015-16 Budget. It includes all appropriations made available to the entity in the year (+/- section 75 transfers, formal reductions, Advance to the Minister for Finance, movements of funds and other quarantines). It is to be the same as the comparator figure included in the Appropriation Bills, and as such provides a comparison with the appropriation proposed for the budget year.

Administered Item
 Appropriation that consists of funding managed on behalf of the Commonwealth. This funding is not at the discretion of the entity and any unspent appropriation is returned to the CRF at the end of the financial year. An administered item is a component of an administered programme. It may be a measure but will not constitute a programme in its own right.

Agency Advice Unit (AAU)
Advisers within Budget Group, Department of Finance that analyse expenditure trends of entities, cost New Policy Proposals, validate entities programme estimates and advise entities on financial and budget matters.

Appropriation
An amount of public money the Parliament authorises for spending (i.e. funds to be withdrawn from the CRF). The Parliament makes laws for appropriating money under the Annual Appropriation Acts and under Special Appropriations, with spending restricted to the purposes specified in the Appropriation Acts.

Appropriations and Cash Management Module (ACM)
A module of the Central Budget Management System from which entities draw down funds from the CRF.

Budget Paper 1 (BP1)
Budget Strategy and Outlook. Provides information on the economic and fiscal outlook for the Australian Government, including information on the Government’s fiscal strategy.
**Budget Paper 2 (BP2)**  
Budget Measures. Provides a description of each budget measure (revenue, expense and capital) by Portfolio.

**Budget Paper 3 (BP3)**  
Australia's Federal Relations. Provides information and analysis on Federal funding provided to the States, Territories and local government.

**Budget Paper 4 (BP4)**  
Entity Resourcing. Details total resourcing available to agencies.

**Central Agencies**  
The Department of the Prime Minister and Cabinet, the Department of the Treasury and the Department of Finance.

**Central Budget Management System (CBMS)**  
CBMS is the Australian Government’s central budget and financial management information system administered by the Department of Finance. It contains the Commonwealth’s programme list and produces the annual Appropriation Bills.

**Classification of Functions of Government (COFOG)**  
The classification of functions of government (COFOG) is a classification used to identify the socio-economic objectives of current transactions, capital outlays and acquisition of financial assets by general government and its sub-sectors. Further information can be found in the International Monetary Fund’s System of National Accounts.

**Clear Read Principle**  
Under the Outcomes arrangements there is an essential clear link between the Appropriation Bills, the PB Statements, the PAES, and annual reports of entities. Information should be consistent across these and other budget documents, and where possible, duplication of reporting within the PB Statements should be avoided. This is called the “clear read” between the different documents.

Under this Principle the planned performance in PB Statements is to be provided on the same basis as actual performance in the annual reports covering the same period, to permit a clear read across planning and actual performance reporting documents. Entities should take this into account in designing their performance reporting arrangements.

**Consolidated Revenue Fund (CRF)**  
The principal operating fund from which money is drawn to pay for the activities of the Government. Section 81 of the Australian Constitution provides that all revenue raised or monies received by the Executive Government forms one consolidated revenue fund from which appropriations are made for the purposes of the Australian Government.
Contractor
A person engaged by an entity, usually on a temporary basis. Treated as an employee of the entity for the purposes of programme performance reporting.

Departmental Item
Resources (assets, liabilities, revenues and expenses) that the entity's Accountable Authority controls directly. This includes outsourced activities funded and controlled by the entity. Examples of departmental items include entity running costs, accrued employee entitlements and net appropriations. A departmental item is a component of a departmental programme.

Entities
For the purposes of this guidance, this means Commonwealth entities and Commonwealth companies as defined under the Public Governance, Performance and Accountability (PGPA) Act 2013 that are within the General Government Sector; the High Court of Australia; and the Future Fund Board of Guardians.

Estimated Actual Expenses
Details of the current year's estimated final figures as included in the Budget documentation. As the Budget is released in May each year, but the financial year does not end until 30 June, the current year numbers that are used for comparison with Budget amounts can only be estimates.

Expenses not requiring appropriation in the Budget year
Expenses not involving a cash flow impact are not included within the calculation of an appropriation. An example of such an event is goods or services received free of charge that are then expensed: e.g. Australian National Audit Office (ANAO) audit services — the ANAO does not charge for audit services however the expense must be recognised. Similarly, bad debts are recognised as an expense but are not recognised for the purpose of calculating appropriation amounts to be sought from Parliament.

Financial Management Information System (FMIS)
A system that holds the financial information of an entity.

Forward Estimates Period
The three years following the budget year. For example if 2015-16 is the budget year, 2016-17 is forward year 1, 2017-18 is forward year 2 and 2018-19 is forward year 3. This period does not include the current financial (2014-15) or the budget year.

General Government Sector (GGS)
A Government Finance Statistics' classification of all entities that are controlled and largely funded by the Australian Government. The GGS provides public services that are mainly non-market in nature and for the collective consumption of the community, or involve the transfer or redistribution of income. These services are largely financed through taxes and other compulsory levies, user charging and
external funding. This sector comprises all government departments, offices and some other bodies.

**Government Finance Statistics (GFS)**

A reporting framework that is a specialised statistical system designed to support economic analysis of the public sector. It allows for comprehensive assessments of the economic impact of government and is consistent with international statistical standards of the International Monetary Fund and the System of National Accounts.

**Intended Result**

Intended result is a key part of an outcome statement and describes the goal or objective of an agency. The intended result is typically distilled from the Government’s economic, social, health or environmental policy goals.

**Materiality**

Is government financial or other information that if omitted, misstated or not disclosed has the potential to adversely affect decisions about the allocation of resources made by users of the financial report, or the discharge of accountability by the management or governing body of an entity.

**Measure**

A new policy or savings decision of the government with financial impacts on the government’s underlying cash balance; fiscal balance; operating balance; headline cash balance; net debt or net worth. Such proposals are normally made in the context of the annual Budget, and are typically published in BP2, in the Mid-Year Economic and Fiscal Outlook (MYEFO) and in the Pre-election Economic and Fiscal Outlook (PEFO).

**Mid-Year Economic and Fiscal Outlook (MYEFO)**

The MYEFO provides an update of the government's budget estimates by examining expenses and revenues in the year to date, as well as provisions for new decisions that have been taken since the Budget. The report provides updated information to allow the assessment of the government’s fiscal performance against the fiscal strategy set out in its current fiscal strategy statement.

**Official Public Account (OPA)**

The OPA is the Australian Government's central bank account held within the Reserve Bank of Australia. The OPA reflects the operations of the Consolidated Revenue Fund.

**Operating Expenditure (of Heritage and Cultural Assets)**

The following is a list of expenditure items that Collection Institutions might include in operating expenditure for heritage and cultural assets:

a. supply of goods and services, for example, outsourced repairs to artwork or insurance costs;

b. direct labour on-costs, for example, the salaries and associated costs of staff researching and restoring items, lease of storage facilities;
c. associated utility costs (electricity, water, gas);
d. cataloguing costs;
e. containers and packaging and transportation;
f. cleaning of collections and storage facilities; and
g. substitution costs (preparation of copies/surrogates of art work for public display).

The costs above do not include full absorption costing such as an allocation for Corporate Administration Costs or costs that are eligible to be capitalised.

Depreciation is not operating expenditure for the purposes of this definition.

Outcome
An outcome is the intended result, consequence or impact of Government actions on the Australian community.

Outcome Statement
An outcome statement articulates the intended results, activities and target group of an Australian Government entity. An outcome statement serves three main purposes within the financial framework:

- to explain and control the purposes for which annual appropriations are approved by the Parliament for use by entities;
- to provide a basis for annual budgeting, including (financial) reporting against the use of appropriated funds; and
- to measure and assess entity and programme (non-financial) performance in contributing to Government policy objectives.

Portfolio Budget Statements (PB Statements)
Budget related paper detailing budget initiatives and explanations of appropriations specified by outcome and programme by each entity within a Portfolio.

Portfolio Budget Submission (PB Submission)
A Cabinet Submission produced by every Portfolio outlining Budget requests. This submission will include New Policy Proposals for agencies seeking funding and will be considered by the Expenditure Review Committee of Cabinet as part of the annual Budget process.

Programme
Activity that delivers benefits, services or transfer payments to individuals, industry and/or the community as a whole, with the aim of achieving the intended result specified in an outcome statement.

Programme Support
The entity's running costs allocated to a programme. This is funded through an entity's departmental appropriations.
Public Governance, Performance and Accountability Act 2013 (PGPA Act)

The Public Governance, Performance and Accountability Act 2013 replaced the Financial Management and Accountability Act 1997 (FMA Act) and the Commonwealth Authorities and Companies Act 1997 (CAC Act) on 1 July 2014. As the primary piece of Commonwealth resource management legislation, the PGPA Act establishes a coherent system of governance and accountability for public resources, with an emphasis on planning, performance and reporting. The Act applies to all Commonwealth entities and Commonwealth companies.

The PGPA Act sets out main principles and requirements Commonwealth Resource Management Framework. Rules and other legislative instruments establish the requirements and procedures necessary to give effect to the governance, performance and accountability matters covered by the Act.

Senate Estimates Hearings

Senate Standing Committees hold hearings to scrutinise the Appropriation Bills and any explanatory documentation tabled to accompany them. Public Servants are called witnesses to hearings.

Specific Purpose Payments (SPP)

Commonwealth payments to the States for specific purposes in order to pursue important national policy objectives in areas that may be administered by the States.

Sub-function


System of National Accounts (SNA)

The 1993 System of National Accounts (1993 SNA) is a comprehensive, consistent and flexible set of macroeconomic accounts to meet the needs of government and private-sector analysts, policy-makers, and decisions-takers. It was prepared jointly by the International Monetary Fund, the European Union, the Organization for Economic Co-operation and Development, the United Nations, and the World Bank.

Target Group

A specific group being targeted for assistance by government policy.

Transfer

Cash paid to recipients of the applicable programme. This includes welfare payments and tax rebates.